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Limited Liability Statement 
 

Extreme care should be exercised when using or servicing this equipment. It should be used or serviced 
only by personnel with knowledge of and training in the use and maintenance of oceanographic 
electronic equipment. 

 
SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing 
of this system. SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment 
or of choosing the personnel to operate it, and therefore cannot take steps to comply with laws 
pertaining to product liability, including laws which impose a duty to warn the user of any dangers 
involved in operating this equipment. Therefore, acceptance of this system by the customer shall be 
conclusively deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD 
ELECTRONICS, INC. harmless from all product liability claims arising from the use or servicing of 
this system. 
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Section 1: Introduction 
 
This section includes contact information, Quick Start procedure, photos of a 
standard SBE 26 SEAGAUGE Wave and Tide Recorder, and shipping 
precautions for lithium batteries. 
 
 

About this Manual 
 
This manual is for use with the SBE 26 SEAGAUGE Wave and Tide Recorder. 
It is organized to guide the user from installation through operation, and data 
collection and processing. We’ve included detailed specifications, command 
descriptions, maintenance and calibration information, and helpful notes 
throughout the manual. 
 
Sea-Bird welcomes suggestions for new features and enhancements of our 
products and/or documentation. Please contact us with any comments or 
suggestions (seabird@seabird.com or 425-643-9866). Our business hours are 
Monday through Friday, 0800 to 1700 Pacific Standard Time (1600 to 0100 
Universal Time) in winter and 0800 to 1700 Pacific Daylight Time (1500 to 
0000 Universal Time) the rest of the year. 
 
 

Quick Start 
 

Follow these steps to get a Quick Start using the SBE 26. The manual provides 
step-by-step details for performing each task. 
 

Deployment: 
 
1. Run Plan Deployment and Battery and Memory Endurance to determine 

sampling parameters (Section 4). 
 
2. Install new batteries. 

 
3. Connect SBE 26 to computer and run SeatermW (Section 5): 

A. Ensure all data has been uploaded, and then send IR to make entire 
memory available for recording if desired. 

B. Set date and time (ST) and wave and tide sampling parameters (SI);  
enable conductivity if SBE 4M conductivity sensor is installed (CY). 

C. Check status (DS) and calibration coefficients (DC). 
D. Start logging (GL). 

 
Recovery and Data Processing: 
 
1. Connect SBE 26 to computer and run SeatermW. Quit logging (QL), and 

upload data from SBE 26 memory (Section 5). 
 
2. Run Convert Hex to convert raw data into separate wave and tide files 

(Section 6). 
 

3. Run Merge Barometric Pressure to remove barometric pressure from  
tide file (Section 7). 

 
4. Run Process Wave Burst Data and Create Reports to calculate and 

summarize wave statistics (Section 8). 
 

5. Run Plot Data to display the data (Section 9). 
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Unpacking SBE 26 
 
Shown below is a typical SBE 26 shipment. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

9-pin adapter 

Spare parts kits (2) 

Software, and Electronic Copies of 
Software Manuals and User Manual 

Pressure Sensor  
Oil refill kit 

Jackscrew Kit 

I/O Cable 

SBE 26 in plastic housing 
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Shipping Precautions – Electrochem Lithium Batteries 
 
The SBE 26 may be powered with Electrochem Lithium Batteries. Sea-Bird 
supplied these batteries as an option for the SBE 26 until February 2004, but 
does not supply these batteries anymore because of changes in regulations 
governing shipment of lithium batteries. Sea-Bird does sell a lithium battery 
pack kit, for building a battery pack using lithium batteries purchased 
elsewhere. The following applies only to Lithium batteries, not to the standard  
alkaline batteries. 
 
 
The Law 
 
U. S. domestic transportation of Electrochem lithium batteries is regulated by 
the Department of Transportation (DOT) through Title 49 Code of Regulation 
(49 CFR), HM-181 part 173.185. Internationally, air transportation is 
regulated by the International Air Transport Association (IATA). Pursuant to 
49 CFR 173.185, all shipments of hazardous materials must comply with 
packaging regulations based on recommendations made by the United Nations. 
 
The shipper is responsible for compliance with the law. Sea-Bird cannot 
advise you on this matter; consult the proper authorities. 
 
 
Shipping 
 
Note that the batteries must not be shipped inside the instrument. 
 
If you will re-ship the SBE 26 by commercial aircraft: 
 
1. Remove the batteries from the SBE 26. 
2. Properly package and label the batteries, and fill out the required 

Dangerous Goods documentation. 
 
 
If you will be shipping your SBE 26 to Sea-Bird for servicing or calibration, 
DO NOT RETURN THE ELECTROCHEM LITHIUM BATTERIES  
TO SEA-BIRD. Remove and store the batteries for future use, or dispose  
of properly. If you send the batteries to Sea-Bird, we will not ship them back 
to you. We will dispose of the batteries unless you are able to arrange to pick 
them up at Sea-Bird.  
 

 

Note: 
Remaining battery capacity for 
used Electrochem lithium 
batteries is not known and cannot 
be determined without 
consumptive testing. We do not 
recommend reusing them 
unless you can positively 
determine how many samples 
were recorded with the batteries 
since their purchase. 
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Section 2: Description of SBE 26 
 
This section describes the functions and features of the SBE 26, including 
specifications, dimensions, power supply, and data I/O protocols. 
 
 

System Description 
 
The SBE 26 SEAGAUGE Wave and Tide Recorder combines Sea-Bird's 
reliable semiconductor-memory electronics with a stable time base, quartz 
pressure sensor, precision thermometer, and an optional SBE 4M conductivity 
sensor to provide wave and tide recording of unprecedented resolution  
and accuracy. 
 
For tide and water level monitoring, the pressure sensor output is continuously 
integrated to average out wave action. The user-programmable tide integration 
time can be set from 1 minute to 500 hours, on 1-minute intervals. High-
accuracy temperature information is recorded with each tide measurement. As an 
option, an SBE 4M conductivity sensor can be installed for recording 
conductivity data with each tide measurement. Waves are characterized by burst 
sampling, with the number of samples per burst, burst interval, and burst 
integration time programmed by the user. 
 
The SBE 26 is self-contained in a rugged non-corroding plastic housing  
(600-meter depth rating); optional titanium housing for depths to 7000 meters is 
available. After recovery (and without opening the housing), the recorded data is 
transferred to a computer via an RS-232C data link for analysis, plotting, and 
permanent archiving. The battery compartment contains nine standard alkaline 
D-cells and is sealed separately to minimize risk to the electronics. 
 
The standard pressure sensor is a 20 meter (45 psia) Quartzonix, with a 
temperature-compensated quartz element. An optional Paroscientific Digiquartz 
pressure sensor with a temperature-compensated quartz element is available in 
13 ranges, from 1 to 6800 meters (15 to 10,000 psia). Temperature is measured 
with an aged, super-stable thermistor embedded in the SBE 26 end cap. 
 
Tide measurements are obtained by continuously counting the pressure 
frequency with a 40-bit ripple counter. Each time the SBE 26 wakes up, the 
ripple counters are latched into registers and then reset. The wake-up times are 
set by a continuously powered, real-time clock with an accuracy of 5 ppm and a 
resolution of 2 milliseconds. 
 
Wave burst measurements are made with a period counter, with its time base 
generated from a temperature-compensated, precision quartz crystal oscillator. 
 
SBE 26 options include: 
• SBE 4M conductivity sensor 
• Titanium housing for use to 7000 meters (22,960 feet) 
• Digiquartz pressure sensor 
• Wet-pluggable bulkhead connectors in place of Impulse glass-reinforced 

epoxy bulkhead connectors 
• Battery pack kit for lithium batteries for longer deployments (lithium 

batteries not supplied by Sea-Bird) 
• Mounting fixture 
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The SBE 26 is supplied with a with a modular Windows 95/98/NT/2000/XP 
software package, Seasoft for Waves. The software provides pre-deployment 
planning, communication with the SBE 26 for setup and uploading of data, 
separation of the raw data into separate wave and tide files, removal of 
barometric pressure from tide data, statistical analysis, and data plotting.  
 
 
 
 
 

Notes: 
• Sea-Bird supplies the current 

version of our software when you 
purchase an instrument. As software 
revisions occur, we post the revised 
software on our FTP site. See our 
website (www.seabird.com) for the 
latest software version number, a 
description of the software changes, 
and instructions for downloading the 
software from the FTP site. 

• Help files provide detailed information 
on Seasoft for Waves. 
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Specifications 
 

Pressure 

Range 
0 to 1/ 5/ 10/ 20/ 60/ 130/ 200/ 270/ 680/ 1300/ 2000/ 4000/ 
6800 meters (15/ 23/ 30/ 45/ 100/ 200/ 300/ 400/ 1000/ 
2000/ 3000/ 6000/ 10000 psia) 

Accuracy* 0.01% of full scale (3 mm for 45 psia range) 
Repeatability * 0.005% of full scale (1.5 mm for 45 psia range) 
Hysteresis * 0.005% of full scale (1.5 mm for 45 psia range) 
Calibration 0 psia to full scale pressure 
Tide 
Resolution * 

0.2 mm for 1-minute integration;  
0.01 mm for 15-minute integration 

Wave 
Resolution * 

0.4 mm for 0.25-second integration;  
0.1 mm for 1-second integration 

* Stated values in mm for accuracy, repeatability, hysteresis, and resolution are 
for 45 psia (20 m) pressure sensor. Scale for other ranges, multiplying by 
(actual sensor range in psia / 45 psia). 
Temperature 
Range -5 to +35 °C 
Accuracy 0.02 °C 
Resolution 0.01 °C 

Calibration +1 to +32 °C (measurements outside this range may be at 
slightly reduced accuracy due to extrapolation errors) 

Conductivity (optional SBE 4M conductivity sensor) 
Range 0.0 to 7 S/m 

Accuracy 

±0.0003 S/m/month (typical); 
±0.001 S/m/month (guaranteed; not applicable in areas of 
high bio-fouling or contamination or if Application Note 
2D procedures are not followed) 

Resolution 0.00002 S/m 
Calibration 2.6 to 6 S/m plus zero conductivity (air) 

Note: 
The pressure sensor is mounted on 
the titanium connector end cap, with 
the pressure conveyed from the 
pressure port to the sensor via an oil-
filled tube. The pressure reading is 
position sensitive as a result of the oil 
pressure head. 
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Other Specifications 
Counter  
Time Base 

Quartz TCXO ± 2 ppm per year aging;  
± 2 ppm per year versus temperature (-5 to 30 °C) 

Memory 8M byte CMOS static RAM, battery-backed for minimum of 
2-years data retention 

Data Storage 

Recorded Parameter Bytes/Sample 
Tide with temperature 4 
Tide with temperature & optional conductivity 8 
Wave burst 3 

Real-Time 
Clock 

Watch-crystal type 32,768 Hz; battery-backed for minimum 
of 1-year operation, regardless of condition of main battery. 
Corrected for drift and aging by comparison to counter  
time base. Accuracy 5 ppm, resolution 2 milliseconds. 

Current 
Requirements 

Quiescent current when not logging: 90 microamps 
Quiescent current when logging: 1.2 ma  
(while integrating pressure in-between tide samples, only counter, 
real-time clock, and pressure sensor are on; microprocessor and 
digital electronics are off except for a 4.4-second period during each 
tide measurement, and duration of each wave burst) 
Operating current (for 4.4-second period during each tide 
measurement, and duration of each wave burst) 

Without conductivity sensor: 65 ma 
With conductivity sensor: 75 ma 

Power Supply 

9 alkaline D-cell batteries: Typical capacity 5 (cold water) to  
10 amp-hours (warm water) 
Optional lithium batteries (batteries not supplied by  
Sea-Bird): Typical capacity of 9 D-cells 42 amp-hours;  
3 DD-cells 30 amp-hours 
Optional External power source: 10 - 20 VDC 

Weight In air, standard housing: 6 kg (13 lbs) 

Housing 
Materials 

Standard: 600-meter acetal copolymer (plastic) pressure 
case with titanium end cap 
Optional: 7000-meter titanium pressure case and end cap 
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Dimensions and End Cap Connectors 
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Power Supply 
 
The main batteries for a standard SBE 26 are nine D-cell alkaline batteries 
(Duracell MN 1300, LR20). The SBE 26 can also be powered by lithium 
batteries; Sea-Bird can supply a lithium battery pack kit (lithium batteries not 
supplied by Sea-Bird). For lithium batteries, see Shipping Precautions – 
Electrochem Lithium Batteries in Section 1: Introduction. 
 
The SBE 26 can also be powered from an external 10-20 VDC source. The 
internal batteries are diode-OR’d with the external source, so power is drawn 
from whichever voltage source is higher. 
 
On-board lithium batteries (non-hazardous units which are unrestricted for 
shipping purposes) are provided to back-up the buffer and the real-time clock in 
the event of main battery failure, exhaustion, or removal. The main batteries can 
be replaced without affecting either the real-time clock or the memory. 
 
 

Data I/O 
 
The SBE 26 receives setup instructions and outputs diagnostic information or 
previously recorded data via a three-wire RS-232 link. The SBE 26 is factory-
configured for 9600 baud, 7 data bits, 1 stop bit, and even parity. 
 
• The baud rate for general communication (setup and diagnostics) cannot  

be changed by the user. 
 
• The baud rate for uploading data from memory can be user-programmed to 

9600, 19200, or 38400 baud. 
 

Notes: 
• For battery endurance calculations, 

see Section 4: Pre-deployment 
Planning – Plan Deployment and 
Battery and Memory Endurance. 

• The cut-off voltage is 7.0 volts.  
If the voltage falls below that, the 
SBE 26 provides a warning 
message, and will not take 
measurements. 
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Section 3: Software Installation and Use 
 

This section describes the installation and use of Seasoft for Waves.  
 
The SBE 26 is supplied with a modular Windows 95/98/NT/2000/XP software 
package software package, Seasoft for Waves. The software provides pre-
deployment planning, communication with the SBE 26 for setup and uploading 
of data from the SBE 26, separation of the raw data into separate wave and tide 
files, removal of barometric pressure from tide data, statistical analysis, and data 
plotting. 
 
 
 
 
 
 
 

Software Installation 
 

Sea-Bird recommends the following minimum system requirements for 
installing the software: Windows 2000 or later, 500 MHz processor, 256 MB 
RAM, and 90 MB free disk space for installation. Although Seasoft for Waves 
was designed to work with a PC running Win 2000/XP, extensive testing has 
not shown any compatibility problems when using the software with a PC 
running Vista or Windows 7 (32-bit). 
 
If not already installed, install Seasoft for Waves on your computer using the 
supplied software CD-ROM: 
 
1. Insert the CD in your CD drive. 
 
2. Install the software: 

A. In the CD-ROM drive, double click on SeasoftWaves_V*_**.exe  
(*_** = software version). 

B. Follow the dialog box directions to install the software. 
The default location for the software is  
c:/Program Files/Sea-Bird/SeasoftWaves. 

 
 

Notes: 
• Help files provide detailed 

information on Seasoft for Waves. 
• Sea-Bird supplies the current 

version of our software when you 
purchase an instrument. As 
software revisions occur, we post 
the revised software on our FTP 
site. See our website 
(www.seabird.com) for the latest 
software version number, a 
description of the software 
changes, and instructions for 
downloading the software from the 
FTP site. 
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Seasoft for Waves Use 
 

Start Seasoft for Waves by double clicking on SeasoftWavesLaunch.exe. The 
main screen looks like this: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Run menu lists each program module: 
 

Type Module Name Module Description 

Pre-deployment 
planning 

See Section 4 

Plan Deployment 

Calculate ratio of pressure amplitude 
measured by instrument to pressure 
amplitude at surface. Predict number of 
frequency bands calculated, width of each 
band, and frequency span. 

Battery and 
Memory 

Endurance 

Calculate nominal battery and  
memory endurance for user-specified 
sampling scheme. 

Terminal program 
See Section 5 SeatermW Send commands for status, data acquisition 

setup, diagnostics, and data upload. 

Data conversion 
See Section 6 Convert Hex 

Convert uploaded raw data file into separate 
wave and tide files, with output data in 
engineering units. 

Tide data processing 
See Section 7 

Merge 
Barometric 

Pressure 
Remove barometric pressure from tide data. 

Wave data processing 
See Section 8 

Process Wave 
Burst Data Compute wave statistics. 

Create Reports 
Output one line of surface wave time series 
and/or wave burst auto-spectrum statistics 
for each processed wave burst. 

Data plotting 
See Section 9 Plot Data 

Plot data from a .tid, .wb, .was, .wts, and/or 
.wt file; plots can be printed. Plot Data can 
plot data at any point after raw hex data is 
converted into separate wave and tide files 
in Convert Hex. 
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File Types 
 

File extensions are used by Seasoft for Waves to indicate the file type: 
 
Extension Description 

.bmp Bitmap graphics file created by Plot Data. 

.bp 

Barometric pressure data, used by Merge Barometric Pressure to 
remove barometric pressure from the tide data (.tid) file. This 
file, not supplied by Sea-Bird, is created by user, based on local 
barometric pressure data (such as that from a local weather 
station). See Section 7: Tide Data Processing – Merge 
Barometric Pressure. 

.cap Data and/or diagnostics captured using SeatermW. 

.hex Raw Hex data uploaded from SBE 26 memory using SeatermW. 

.ini 

There are two .ini files used in Seasoft for Waves: 
• SeasoftWaves.ini contains the location and file name of the 

last saved Program Setup (.psa) file and options settings for 
each module with a .psa file (Convert Hex, Merge Barometric 
Pressure, Process Wave Bursts, Create Reports, and  
Plot Data). 

• SeatermW.ini contains the last instrument type (SBE 26, 
26plus, or 53), COM port, and baud rate used in SeatermW 
for communicating with the instrument. 

The .ini files are saved to  
%USERPROFILE%\Local Settings\Apps\Sea-Bird  
(Example C:\Documents and Settings\dbresko\ 
Local Settings\Apps\Sea-Bird) 

.jpg JPEG graphics file created by Plot Data. 

.psa 

Program Setup file, used by Convert Hex, Merge Barometric 
Pressure, Process Wave Bursts, Create Reports, and Plot Data to 
store setup information (such as input and output file names and 
locations, and processing instructions). 
The user can save the .psa files to the desired locations.  
As a default, the .psa files are saved to  
%USERPROFILE%\Application Data\SeasoftWaves  
(Example C:\Documents and Settings\dbresko\ 
Application Data\Sea-Bird\SeasoftWaves). 

.r26 
File containing one line of surface wave time series and/or wave 
burst auto-spectrum statistics for each processed wave burst, 
created by Create Reports. 

.rpt Summary report, created by Process Wave Burst Data. 

.tid 
Tide measurements in engineering units, created from raw .hex 
file by Convert Hex. Also, file format for tide data that has had 
barometric pressure removed by Merge Barometric Pressure. 

.was Statistics and results from auto-spectrum analysis, created by 
Process Wave Burst Data. 

.wb Wave measurements in engineering units, created from raw .hex 
file by Convert Hex. 

.wmf Windows metafile graphics file created by Plot Data. 

.wss Fast Fourier Transform coefficients, created by Process Wave 
Burst Data if selected. 

.wt Surface wave time series, created by Process Wave Burst Data  
if selected. 

.wts Statistics from surface wave zero crossing analysis, created by 
Process Wave Burst Data. 

See Appendix III: Data Formats for details on the format of each file. 
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Section 4: Pre-Deployment Planning –  
Plan Deployment and Battery and Memory Endurance 

 
This section covers: 
• Planning the required wave burst parameters and placement of the  

SBE 26, using the Plan Deployment module in Seasoft for Waves. 
• Calculating battery and memory endurance for the desired sampling 

scheme, using the Battery and Memory Endurance module in  
Seasoft for Waves. 

 
 

Plan Deployment 
 
Plan Deployment solves the wave dispersion relation to calculate and plot the 
pressure attenuation ratio: 
 

Pressure attenuation ratio =  pressure amplitude measured by SBE 26 
                                                         pressure amplitude at surface 

given: 
water depth (meters) 
height of pressure sensor above bottom (meters) 
wave period (seconds) 

 
Pressure attenuation with depth is a strong function of the wave period; short 
period waves are attenuated much faster with depth than longer period waves. 
This implies that for a pressure sensor deployed at a fixed depth z, there is a high 
frequency cut-off fmax for which waves with f > fmax are not measurable. 
Above the high frequency cut-off, any noise in the subsurface pressure record is 
mapped by the transfer function into unrealistic surface wave height values. 
 
The default high-frequency cutoff (fmax) for processing wave data in Process 
Wave Burst Data is the frequency where the ratio of pressure measured by the 
SBE 26 to pressure at the surface is less than (0.0025 / wave sample interval). 
Frequencies greater than fmax are typically not processed by Process Wave 
Burst Data. 
 
Plan Deployment also predicts these surface wave analysis parameters: 
• number of frequency bands calculated 
• width of each frequency band (Hz) 
• frequency span (Hz) 
given: 

water depth (meters) 
height of pressure sensor above bottom (meters) 
wave sample interval (time between successive wave pressure measurements) 
points per wave burst (multiple of 4; for example, 4, 8, 16, etc.) 
number of spectral estimates for each frequency band 

 
The maximum frequency in the frequency span is the lesser of: 
• 0.5 / sample interval (called the Nyquist frequency), or 
• frequency (fmax described above) where ratio of pressure measured by 

SBE 26 to pressure at surface is less than (0.0025 / sample interval) 
 
Appendix VI: Wave Theory and Statistics provides detailed discussion on  
band averaging. 

Note: 
See Appendix VI: Wave Theory  
and Statistics for a detailed 
discussion of the theory and 
equations for wave calculations. 

Note: 
If planning to calculate wave 
statistics, Sea-Bird recommends the 
following for meaningful, valid results:  
• Samples per burst > 512, and 
• Samples per burst = power of 2 (for 

example, 512, 1024, etc.) 
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In Seasoft for Waves’ Run menu, select Plan Deployment. The dialog box 
looks like this: 

 
 

 
 

Example:  
Water depth is 10 meters. You are interested in measuring waves with 
frequencies up to 0.36 Hz (period = 1 / 0.36 = 2.8 seconds). You plan to 
sample waves 4 times per second (wave sample interval = 0.25 seconds) 
with 1024 samples/wave burst, and to process data with  
10 spectral estimates/band. Can you place the SBE 26 at 1 meter  
above the bottom and accomplish your goals? 
 
Running Plan Deployment with the above parameters (see dialog box 
above), the Frequency Span is 0.0215 to 0.3340 Hz. Since 0.3340 < 0.36, 
you cannot accomplish your goals. 
 
Iterating on a solution by changing the instrument height in Plan Deployment, 
you find that placing the SBE 26 at 2.5 meters above bottom will allow you to 
measure the desired frequencies. Alternatively, you could consider modifying 
other sampling parameters while maintaining the instrument height. 

Enter values and then click 
Calculate Spectral Parameters to 
calculate bands, band width, and 
frequency span, and calculate 
and plot pressure attenuation. 
Note that wave sample duration 
and wave samples per burst  
are programmed into SBE 26 
with SI. 

Pressure attenuation is wave 
pressure amplitude measured by 
instrument divided by wave 
pressure amplitude at surface. 
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Battery and Memory Endurance 
 

Power and memory endurance calculations for the SBE 26 are complex, and 
are dependent on the sampling scheme. Use Battery and Memory Endurance to 
calculate the endurance for a user-specified sampling scheme. 
 
In Seasoft for Waves’ Run menu, select Battery and Memory Endurance. 
Click on the SBE 26 tab in the dialog box. The dialog box looks like this: 

 
 
 

 
 

Note: 
See Specifications in Section 2: 
Description of SBE 26 for power and 
memory specifications. 

Enter tide measurement interval, number of 
tide measurements between each wave 
burst, wave samples/burst, wave sample 
duration, and whether conductivity is also 
measured. Sampling setup is programmed 
into SBE 26 with SI; conductivity sampling 
is programmed into SBE 26 with CYor CN. 

(Battery capacity / daily power consumption) 
• Based on input sampling scheme and  

nominal 8 amp-hour capacity 

Wave samples/burst * Wave sample duration 

Based on input sampling scheme 
and memory storage requirements. 

Click Calculate to calculate battery 
and memory endurance. 

Notes: 
• This drawing is schematic only, intended 

to define the sampling scheme 
terminology. See Appendix II:  
Sample Timing for timing details. 

• See Command Descriptions in Section 5: 
SBE 26 Setup, Installation, and Data 
Upload – SeatermW for programming 
desired sampling scheme in SBE 26. 



Manual revision 017 Section 4: Pre-Deployment Planning – Plan Deployment and Battery and Memory Endurance SBE 26 

 20 

Discussions follow of the data and equations used in Battery and Memory 
Endurance; use this information to perform your own calculations if desired. 
 
Battery Endurance 
 
• Quiescent power consumption when logging (amp-hours per day) 

Only counter, real-time clock, and pressure sensor are on continuously 
while logging. 
1.2 mA * 86400 seconds/day * 1 hr/3600 second * 1 amp /1000 ma  
     = 0.0288 amp-hours/day 

 
• Tide measurement 

On time for microprocessor and digital electronics during each  
tide measurement = 4.4 seconds. 

 
Power consumption (amp-hours) during tide measurement on time: 

 
Without conductivity sensor (65 ma operating current) 
4.4 seconds * 65 ma * 1 hr/3600 second * 1 amp/1000 ma  
     = 8.0 x 10 -5 amp-hours 
 
With conductivity sensor (75 ma operating current) 
4.4 seconds * 75 ma * 1 hr/3600 second * 1 amp/1000 ma  
     = 9.2 x 10 -5 amp-hours 

 
• Wave measurement 
 

Wave burst duration =  
[number of wave measurements * wave integration time (seconds)] + 1 
 
Power consumption (amp-hours) during each wave burst =  
65 ma * 1 hr/3600 second * 1 amp/1000 ma 
     = 1.8 x 10 -5 amp-hours / second of wave burst 
 

• Total power consumption (amp-hours) 
 
Without conductivity sensor 
(total number of days * 0.0288) +  
(total number of tide measurements * 8.0 x 10 -5) +   
(total number of wave burst measurements * burst duration * 1.8 x 10 -5) 
 
With conductivity sensor 
(total number of days * 0.0288) +  
(total number of tide measurements * 9.2 x 10 -5) +  
(total number of wave burst measurements * burst duration * 1.8 x 10 -5) 
 

 
 
 

Note: 
See Specifications in Section 2: 
Description of SBE 26 for power 
requirements and battery ratings. 

Example: SBE 26 without conductivity sensor; with standard alkaline batteries. 
Measure tides every 15 minutes (4/hour * 24 hours = 96 measurements/day).  
Measure waves after every 24 tide samples (96 / 24 = 4 wave bursts/day).  
Take 512 wave measurements per burst, at 0.25-second integration time per measurement. 
Wave burst duration / day = 4 [(512 * 0.25) + 1] = 516 seconds. 
Assume 8 amp-hours of battery capacity. 
(Note: This is same sampling scheme as shown in Battery and Memory Endurance dialog box above.) 
 
Power consumption = [(0.0288) + (96 * 8.0 x 10 -5 ) + (516 * 1.8 x 10 -5 )] * Number of Days 
Power consumption = 0.045768 * Number of Days 
Number of days of battery capacity = 8 amp-hours / 0.045768 = 174.8 days 
As a check, compare with the output of Battery and Memory Endurance on the SBE 26 tab; the program shows 
approximately the same results.  
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Memory Endurance 
 
The SBE 26 comes standard with an 8 MB memory. Memory used for storing 
logged data is: 
 

Bytes/day =4 * ( N + C + W [ ( 0.75 * M ) + 4 ] ) 
 

where 
N = number of tide samples/day 
C = N = number of conductivity samples/day (if conductivity enabled) 
W = number of wave bursts/day 
M = number of wave measurements/burst 

 
 
 

Example: SBE 26 without conductivity sensor. 
Measure tides every 15 minutes (4/hour * 24 hours = 96 measurements/day).  
Measure waves after every 24 tide samples (96 / 24 = 4 wave bursts/day).  
Take 512 wave measurements per burst. 
(Note: This is same sampling scheme as shown in Battery and Memory Endurance dialog box above, and in power 
endurance calculation examples.) 
 
N = 96, C = 0 (no conductivity sensor), W = 4, M = 512 
Bytes/day = 4 * ( 96 + 0 + 4 [ ( 0.75 * 512 ) + 4 ] ) = 6592 bytes/day 
Memory capacity ≈  8 MB * 1024 * 1024 = 8,388,608 bytes 
Memory endurance ≈  8,388,608 / 6592 = 1272.5 days 
 
As a check, compare with the output of Battery and Memory Endurance; the programs shows approximately the same 
results. Note that for this example, the SBE 26 memory capacity far exceeds the power capacity. 

Note: 
In response to the status (DS) or 
sample interval (SI) command, the  
SBE 26 calculates memory endurance 
for the given sampling scheme, taking 
into account the number of samples 
already in memory. Battery and 
Memory Endurance calculates the  
total memory endurance for a  
sampling scheme. 
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Section 5: SBE 26 Setup, Installation, and 
Data Upload - SeatermW 

 
This section covers: 
• Programming the SBE 26 for deployment using SeatermW 
• Command descriptions 
• Installing and deploying the SBE 26 
• Recovery and uploading data from memory using SeatermW 
 
 

Programming for Deployment - SeatermW 
 

 
1. Connect the SBE 26 to the computer using the 4-pin data I/O cable: 

A. By hand, unscrew the locking sleeve from the SBE 26’s I/O  
connector. If you must use a wrench or pliers, be careful not to loosen 
the I/O connector instead of the locking sleeve. 

B. Remove the dummy plug from the SBE 26’s I/O connector by pulling 
the plug firmly away from the connector. 

C. Standard Connector - Install the Sea-Bird I/O cable connector, 
aligning the raised bump on the side of the connector with the large 
pin (pin 1 - ground) on the SBE 26.     OR 
MCBH Connector – Install the cable, aligning the pins. 

D. Connect the I/O cable connector to your computer’s serial port. 
 
 
 
2. In Seasoft for Waves Run menu, select SeatermW.  

The main screen looks like this: 

 
• Menus – Contains tasks and frequently executed instrument 

commands. 
• Command/Data Echo Area – Echoes a command executed using a 

Menu, as well as the SBE 26’s response. Additionally, a command 
can be manually typed in this area, from the available commands for 
the SBE 26. The SBE 26 must be awake for it to respond to a 
command (use Connect to wake up the SBE 26). 

• Status bar – Provides status information. 

Note: 
Once the system is configured and 
connected (Steps 3 and 4 below), to 
update the Status bar, click Status. 
SeatermW sends the status 
command (DS), which displays in 
the Command/Data Echo Area, and 
updates the Status bar. 

Status bar 

Command/Data Echo Area Menus 

Status – Ready, 
Uploading, 
Finished 

Upload, etc. 

Computer Comm 
port, general 

communication 
baud rate, data bits, 
stop bits, and parity 

Instrument 
and 

firmware 
version 

Progress bar for 
uploading data 
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Following is a description of the menus: 
 

Menu Description Equivalent 
Command* 

File Exit SeatermW. - 

Communications 

Connect / Disconnect - Re-establish 
communications with SBE 26. Computer 
responds with S> prompt. 26 goes to sleep 
after 2 minutes without communication from 
computer have elapsed. 
Configure - Establish communication 
parameters (instrument, Comm port, upload 
baud rate). 

(press Enter key ) 

Status Display SBE 26 setup and status (logging, 
samples in memory, etc.). DS 

Coefficients 
Display pressure sensor and temperature sensor 
calibration coefficients that are hard coded in 
SBE 26 EPROM. 

DC 

Upload 

Upload data stored in memory, in format our 
data processing modules can use. Uploaded 
data has .hex extension. Before using Upload, 
send QL to stop logging. 

Upload with DDb,e, 
DEb,e, or DAb,e (use 
Upload if you will be 
processing data with 
Seasoft for Waves) 

Capture 

Capture SBE 26 responses on screen to file; 
may be useful for diagnostics. File has .cap 
extension. Click Capture again to turn off 
capture. Capture status displays in Status bar. 

- 

Stop 

Interrupt and end current activity, such as 
uploading data or running a diagnostic test 
(such as FR or VR). 
Note: This does not stop logging – use QL to 
stop logging. 

(press Esc key several 
times) 

Diagnostic 

Perform diagnostic tests on SBE 26. Diagnostic 
tests accessed in this manner are non-
destructive – they do not write over any 
existing settings. 

DS; DC;  
DD0,10;  

FR 

*See Command Descriptions below. 
 
3. In the Communications menu, select Configure. The dialog box looks like 

this:  

Verify/modify the parameters in the Configuration dialog box. Click OK. 
 

4. In the Communications menu, select Connect. The display looks like this: 
SEAGAUGE POWER ON 
S> 

This shows that correct communications between the computer and SBE 26 
has been established. If the system does not respond with the S> prompt: 
• Select Connect again. 
• Verify the instrument and Comm port were entered correctly in the 

Configure dialog box. 
• Check cabling between the computer and SBE 26. 

Note: 
You must be connected to the 
instrument (Connect in 
Communications menu) when using 
Status, Coefficients, Upload, Stop, 
or Diagnostic. 

Note: 
The SBE 26 communicates at  
9600 baud, 7 data bits, 1 stop bit, 
and even parity, as documented on 
the instrument Configuration Sheet. 

Computer  
Comm port for 
communication 
with SBE 26. 

Upload baud rate 
for communication 
between computer 
and SBE 26.  
Baud for general 
communication is 
always 9600. 

Select SBE 26. 
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5. Display SBE 26 status information by clicking Status; SeatermW sends 
DS. The display looks like this: 
SBE 26 SEAGAUGE V4.1d SN335, 06/06/02 08:37:54.328 
pressure sensor: serial number 36285, range = 45 psi 
clk = 32767.843  iop = 63  vmain = 13.1  vlith = 5.9 
last sample: p = 14.6734  t = 2.227 
 

tide measurement interval = 15 min 
measure waves every 24 tide samples 
128 wave samples/burst at 4.00 scans/second 
 

tide samples/day = 96.000 
wave bursts/day = 4.000 
memory endurance = 4227.482 days 
recorded tide measurements = 0 
recorded wave bursts = 0 
 

conductivity = NO 
logdata = NO 
 

6. Send the desired commands to set up the SBE 26 (see Command 
Descriptions below). Verify the setup by clicking Status again. 

 
7. Test the setup by typing GL and pressing the Enter key to begin logging. 

 
The SBE 26 responds: 

Start logging Y/N? 
Type y and press the Enter key. 
 
The SBE 26 responds: 

Are you sure ^Y/N?       (^ indicates the Ctrl key) 
Hold down the Ctrl key and type y, and press the Enter key. 
 
The SBE 26 displays the sample interval setup, and then asks: 

Set up ok Y/N? 
Type y and press the Enter key. 
 
The SBE 26 responds: 

Start data logging 
 
The first two times the SBE 26 begins a tide measurement, the display shows: 

SEAGAUGE POWER ON 
 
For the third and subsequent tide measurements, the display looks like this: 

SEAGAUGE POWER ON 
Tides: 06/07/02  09:27:02.370 
Psia=14.7705, ptemp=20.92, tvolt=1.268, cfreq=2699.342 

where: 
• time = end of tide interval measurement 
• psia = calculated and stored pressure 
• ptemp = calculated pressure temperature (not stored) 
• tvolt = stored temperature voltage 
• cfreq = conductivity sensor frequency (shown only if conductivity was 

enabled with CY) 
 
When a wave burst measurement is made, the display looks like this: 

aadadadadad 
where: 
• One a always displays at the start. 
• Number of d’s = (wave samples/burst + 1). For this example, the 

number of wave samples/burst is 4, so 5 d’s display. 
• Each d is preceded by (n – 1) a’s, where n = number of 0.25-second 

periods to integrate waves. For this example, n = 2 (two 0.25-second 
periods, corresponding to a wave sampling rate of 1 scan/0.5 seconds, 
or 2 scans/second). 

 

Note: 
The SBE 26 automatically enters 
quiescent (sleep) state after  
2 minutes without receiving a 
command. This timeout algorithm 
conserves battery energy if the user 
does not send QS to put the SBE 26 
to sleep. If the system does not 
appear to respond, select Connect in 
the Communications menu to 
reestablish communications. 

Note: 
See Appendix II: Sample Timing for 
a detailed description of when tide 
and wave measurements are made 
and stored in memory. 
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8. End the test by typing QL and pressing the Enter key to stop logging. 
 
The SBE 26 responds: 

Quit logging Y/N?  
Type y and press the Enter key. 
 
The SBE 26 responds: 

Are you sure ^Y/N?   (^ indicates the Ctrl key) 
Hold down the Ctrl key and type y, and press the Enter key. The SBE 26 
stops logging. 

 
9. (if ready for deployment) Type GL and press the Enter key to begin 

logging again, overwriting any data in memory.  
 
     OR  
 
(if not ready for deployment) Type QS and press the Enter key to 
command the SBE 26 to go to sleep (quiescent state). 
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Command Descriptions 
 
This section describes commands and provides sample outputs. 
See Appendix I: Command Summary for a summarized command list. 
 
When entering commands: 
 
• Input commands in upper or lower case letters and register commands by 

pressing the Enter key. 
 
• The SBE 26 sends # if an invalid command is entered. 

 
• If the system does not return an S> prompt after executing a command, 

press the Enter key to get the S> prompt. 
 

• If a new command is not received within 2 minutes after completion of a 
command, the SBE 26 returns to the quiescent (sleep) state and the 
display indicates     time out. 

 
• If in quiescent state, re-establish communications by clicking Connect or 

pressing the Enter key to get an S> prompt. 
 

• Commands followed by * alter SBE 26 memory and prompt the user twice 
before executing (* is not part of the command). To execute the command, 
type y and press the Enter key in response to  message Y/N. Then hold 
down the Ctrl key and type y, and press the Enter key in response to  
are you sure ^Y/N. Any other responses abort the command. 

 
• The SBE 26 responds only to DS, QS, and QL while logging, and does 

not respond at all while making a wave burst measurement. If you wake 
up the SBE 26 while it is logging (for example, to send DS to check on 
logging progress), it does not interrupt logging. However, the integrated 
pressure frequency is incorrect for the interval when the SBE 26 woke up. 

 
• Use Upload to upload data that will be processed by Seasoft for Waves. 

Manually entering a data upload command does not produce  
data with the required header information for processing by  
Seasoft for Waves. 

 
• If the SBE 26 is uploading data and you want to stop it, press the  

Esc key or click Stop. Press the Enter key to get the S> prompt. 
 
 
 
Entries made with the commands are permanently stored in the SBE 26 and 
remain in effect until you change them. 
 
• The only exceptions occur if the electronics are removed from the housing 

and disconnected from the battery Molex connector (see Appendix IV: 
Electronics Disassembly/Reassembly), or the SBE 26’s reset switch is 
used (see Section 11: Troubleshooting). Upon reassembly or resetting, 
initialize RAM (IR), reset the date and time (ST), and re-enter all the 
setup parameters. 
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Status Commands 
 
DS Display operating status and  

setup parameters.  
 

Equivalent to Status menu. 
 
List below includes, where applicable, 
command used to modify parameter.  
 
• Firmware version, serial number, date  

and time [ST] 
• Pressure sensor serial number and full 

scale range 
• Real-time clock frequency, voltages 

and currents (main operating current, 
main and back-up lithium battery 
voltages) 

• Wait interval after each line of data 
[LWx] – line only appears if not 0 

• Last measured pressure (psia) and 
temperature (ºC) 

• Interval between tide samples [SI] 
• Interval between wave bursts [SI] 
• Number of wave measurements/burst 

[SI] 
• Calculated number of tide 

samples/day [based on SI] 
• Calculated number of wave bursts/day 

[based on SI] 
• Calculated memory endurance for 

sampling scheme [based on SI and 
number of measurements in memory] 

• Number of tide measurements  
in memory 

• Number of wave bursts in memory 
• Enabling of conductivity sensor [Cx] 
• Logging status (logdata=no or yes) 

 

 

Note: 
You can wake up the SBE 26 and 
display status (press Enter key to get 
S>, then click Status) without 
interrupting logging. However, the 
integrated pressure frequency is 
incorrect for the interval when the  
SBE 26 woke up. 

Example: (user input in bold). 
S>DS 
SBE 26 SEAGAUGE V4.1d SN335, 06/06/02 08:37:54.328 
pressure sensor: serial number 36285, range = 45 psi 
clk = 32767.843  iop = 63  vmain = 13.1  vlith = 5.9 
lwait = 1000 msec 
last sample: p = 14.6734  t = 2.227 
 
tide measurement interval = 15 min 
measure waves every 24 tide samples 
128 wave samples/burst at 4.00 scans/second 
 
tide samples/day = 96.000 
wave bursts/day = 4.000 
memory endurance = 4227.482 days 
recorded tide measurements = 0 
recorded wave bursts = 0 
 
conductivity = NO 
logdata = NO 

Note: 
Memory endurance in the DS 
response is based on remaining space 
in memory, taking into account the 
number of tide measurements and 
wave bursts in memory and the setup 
(tide measurement interval, wave 
samples, etc). 
To determine total memory endurance 
for a sampling scheme: 
• Run Battery and Memory 

Endurance, or 
• Verify all logged data has been 

uploaded from memory; delete all 
logged data in memory with IR; and 
send DS again. 

 
For information on battery endurance, 
see Battery and Memory Endurance in  
Section 4: Pre-Deployment Planning –  
Plan Deployment and Battery and  
Memory Endurance for calculating 
power consumption for your intended 
sampling scheme. 
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Status Commands (continued) 
 
DC Display pressure sensor and temperature 

sensor coefficients that are hard coded into  
SBE 26 EPROM. 

 
Setup Commands 
 
IR     * Initialize memory, which destroys all 

logged data in SBE 26 memory. SBE 26 
requires verification before it proceeds.  
All data bits are set to 0; sample number 
and data pointers are set to 0. Allow 
several minutes to initialize memory. 
 

Send IR after uploading all data. Use of 
IR is optional, as SBE 26 writes over 
previously recorded information when  
GL is sent to begin logging. However, 
knowledge of initial memory contents  
(i.e., all zeroes) can be a useful cross-
check when data is retrieved. 

 
 
ST Set real-time clock date and time. 

 

Notes: 
• These calibration coefficients 

should match the Calibration 
Sheets supplied with the SBE 26. 

• Some temperature sensor 
Calibration Sheets list g and x 
instead of AI and XI. Verify that  
g = AI and x = XI. 

• These calibration coefficients are 
hard coded into the SBE 26 
EPROM, and cannot be changed 
by command. Other calibration 
parameters are entered in 
Convert Hex’s Coefficient 
Configuration dialog box when 
converting the raw uploaded 
data to engineering units; see  
Section 6: Conversion into Tide 
and Wave Files – Convert Hex. 

• For discussion of how calibration 
coefficients are generated,  
see Sensor Calibration in  
Section 10: Routine Maintenance 
and Calibration. 

Example: SBE 26 with Paroscientific Digiquartz sensor (user input in bold). 
S>DC 
Paroscientific Digiquartz calibration coefficients: 
U0 = 5.842227 
Y1 = -3.932.789 
Y2 = -11618.080 
Y3 = 0.000 
C1 = 157.03740 
C2 = 20.163780 
C3 = -148.10980 
D1 = 0.0507923 
D2 = 0.000 
T1 = 25.08749 
T2 = 0.4489404 
T3 = 17.33406 
T4 = 0.000 
T5 = 0.000 
M = 9532.5 
B = 4766.3 
Temperature coefficients: 
Z = -49043.5 
RH = 47000.0 
AI = 271800.0 
XI = -8.745 

Example (user input in bold): 
S>IR 
Initialize ram Y/N? y 
Are you sure ^Y/N? ^y (Note: ^ indicates Ctrl key. Hold down Ctrl key and 
type y, and press Enter key.) 
Writing ram 0  
. . 
Writing ram 255 

Example (user input in bold): Set current date and time to 05 October 2002 12:00:00. 
S>ST 
date (MMDDYY)=100502 
time (HHMMSS)=120000 
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Setup Commands (continued) 
 
SI Set sampling intervals and parameters. 

SBE 26 displays present value and asks for 
new value for each parameter. Type in 
desired value and press Enter key. To 
accept present value without change, press 
Enter key. Program prompts as follows: 

 
 
 
 
 
 
 
 
 
 
 

tide interval (integer minutes) = 15 minutes, new value = 
Time for each tide measurement.  
SBE 26 integrates data over this entire 
period, counting frequency signal 
continuously and computing an average 
pressure for the interval. 

 
wave burst after every N tide measurements: N = 4, new value = 

Wave burst is sampled every  
(N * tide interval minutes).  
Maximum is 32767. 

 
wave samples/burst (integer multiple of 4) =128, new value = 

Number of wave measurements/burst.  
If entered number is not multiple of 4,  
SBE 26 rounds down to make it multiple  
of 4. To calculate wave statistics on 
uploaded data, Sea-Bird recommends 
following for meaningful, valid results:  
-- waves samples/burst > 512, and 
-- wave samples/burst = power of 2 (512, 
1024, etc.). 

 
number of 0.25 second periods to integrate waves (1-128) = 1,  

new value =  
SBE 26 samples at maximum rate of 4 Hz 
(0.25 seconds / wave burst measurement). 
This parameter reduces wave burst 
sampling rate and increases integration 
time per measurement (for example, one 
0.25-second period to integrate 
corresponds to wave sample duration of 
0.25 seconds; ten 0.25-second periods to 
integrate corresponds to wave sample 
duration of 2.5 seconds). 
 

SBE 26 then displays a summary of sampling parameters as well as 
the calculated number of samples per day and memory endurance for 
the input sampling scheme (shown in example below). Note that this 
information is also included in DS response. After displaying 
summary, SBE 26 asks: 
 
Wave and tide intervals ok Y/N ? =  

y to save parameters and return to S> 
prompt, or n to start over at first prompt. 

Note: 
This drawing is schematic only, intended to 
define the sampling scheme terminology. See 
Appendix II: Sample Timing for detailed 
description of when tide and wave 
measurements are made and stored in memory. 

Note: 
Memory endurance is based on remaining 
space in memory, taking into account the 
number of tide measurements and wave 
bursts in memory and the setup (tide 
measurement interval, wave samples, etc). 
To determine total memory endurance for a 
sampling scheme: 
1. Verify all logged data has been uploaded 

from memory. 
2. Delete all logged data in memory with IR. 
3. Send SI or DS. 
 
For battery endurance, see Battery and 
Memory Endurance in Section 4: Pre-
Deployment Planning – Plan Deployment and 
Battery and Memory Endurance. 

Note: 
Time required for each wave burst must be 
less than (tide interval - 30 seconds). If the 
user setup does not meet this requirement, 
the SBE 26 reduces the number of 
measurements in the wave burst to meet  
the requirement. 
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Setup Commands (continued) 
 

 
Cx x=Y: Enable conductivity logging  

(if SBE 26 includes optional SBE 4M 
conductivity sensor). 
 
x=N: Disable conductivity logging. 

 
LWx x= wait interval (milliseconds) after each 

line of data. Normally set to 0; increase for 
very old (slow) computers.  
Range 0 - 65535. 

 
QS Quit session and place SBE 26 in 

quiescent (sleep) state. Main power is 
turned off. Memory retention is  
not affected. 

Example (user input in bold): 
Set up SBE 26 to take a tide measurement every 15 minutes (tide interval = 15), 
measure waves after every 24 tide samples (wave burst after every N tide measurements 
= 24), and take 512 wave samples per wave burst (wave samples/burst = 512) at 1 Hz 
(number of 0.25 second periods to integrate waves = 4). 
 
S>SI 
SBE 26 responds with prompts (described above) for you to enter sampling parameters. 
Press Enter key to accept current value, or type in new value and press Enter key. 
 
When finished, a summary of parameters displays. For this example: 
 
tide measurement interval = 15.0 min 
measure waves every 24 tide samples 
512 wave samples/burst at 1.00 scans/second 
 
tide samples/day = 96.000 
wave bursts/day = 4.000 
memory endurance = 1272.544 days 
recorded tide measurements = 0 
recorded wave bursts = 0 
 
Then, SBE 26 prompts: 
Wave and tide intervals ok Y/N ? = Y 
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Logging Commands 
 
GL     * Start logging, which overwrites all 

logged data in SBE 26 memory. 
Therefore, SBE 26 requires verification 
before it proceeds. SBE 26 displays 
sample intervals and then requires 
verification again that setup is OK before 
proceeding. When logging starts, first 
sample number is set to 0, so any 
previously recorded data is written over, 
regardless of whether memory has been 
initialized (IR). 

 
QL     * Quit logging. SBE 26 requires verification 

before it proceeds. 

 
 
Data Upload Commands 
 
Stop logging before uploading data. 
 
DDb,e Upload raw data from memory in 

Hexadecimal from sample b to e at  
9600 baud. If only b is entered, data for 
sample b is displayed. If b and e are 
omitted, all data displays. 

 
DEb,e Upload raw data from memory in 

Hexadecimal from sample b to e at  
19200 baud. If only b is entered, data for 
sample b is displayed. If b and e are 
omitted, all data displays. 

 
DAb,e Upload raw data from memory in 

Hexadecimal from sample b to e at  
38400 baud. If only b is entered, data for 
sample b is displayed. If b and e are 
omitted, all data displays. 

 
 

Notes: 
• Use Upload to upload data to a 

.hex file that will be processed 
by Seasoft for Waves. Manually 
entering DD, DE, or DA does not 
produce data with the required 
header information for processing 
by Seasoft for Waves. These 
commands are included here for 
reference for users who are 
writing their own software. 

• To save data to a file, click 
Capture before entering DD, DE, 
or DA. 

• The SBE 26 pauses for 1 second 
after receipt of DE or DA to  
allow the receiving software to 
change the baud rate. The baud 
automatically changes back  
to 9600 (baud rate for general 
communication) after  
data uploads. 

Example: Start and stop logging (user input in bold). 
S>GL 
Start logging Y/N? y 
Are you sure ^Y/N? ^y (Note: ^ indicates Ctrl key. Hold down Ctrl key and type y, and press Enter 
key.) 
(SBE 26 displays sample interval setup, and then asks:) 
set up ok Y/N? y 
start data logging 
 
(See Programming for Deployment - SeatermW for a description of screen displays while logging.) 
 
(to stop logging, press Enter key several times to get S> prompt) 
S>QL 
Quit logging Y/N? y 
Are you sure ^Y/N? ^y (Note: ^ indicates Ctrl key. Hold down Ctrl key and type y, and press Enter key) 

Note: 
You can wake up the SBE 26 and 
display status (press the Enter key 
to get the S>, then click Status) 
without interrupting logging. 
However, the integrated pressure 
frequency is incorrect for the 
interval when the SBE 26 woke up. 
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Diagnostic Commands 
 
TM     * Memory test, which destroys all data in 

SBE 26 memory. Therefore, SBE 26 
requires verification before proceeding.  
A pattern is written into all locations of 
each RAM. Data in RAM is then 
compared to pattern. 

 
TE     * Extended memory test, which destroys all 

data in SBE 26 memory. Therefore,  
SBE 26 requires verification before 
proceeding. Same as TM test, but  
10 passes are performed, with pattern 
incremented by 1 for each pass. 

 
 
FR Measure and display frequencies: 

Column Output 
1 pf = pressure frequency 

2 tf = pressure temperature 
compensation frequency 

3 
cf = conductivity sensor 
frequency (displays only if 
conductivity enabled with CY) 

SBE 26 runs continuously during test, 
drawing current. Press Esc key or Stop to 
stop test. 
 

VR Measure and display voltages read by  
A/D converter: 

Column Output 
1 Main battery voltage / 5.0161 
2 Lithium battery voltage / 3.873 
3 Raw thermistor voltage 

4 Raw voltage from large 
reference resistor 

5 Raw voltage from small 
reference resistor 

SBE 26 runs continuously during test, 
drawing current. Press Esc key or Stop to 
stop test. 
 

Example: Perform extended memory test (user input in bold). 
S>te 
Extended memory test Y/N? y 
Are you sure ^Y/N? ^y (Note: ^ indicates Ctrl key. Hold down Ctrl key 
and type y, and press Enter key.) 
Pass 1 
Ram 0, OK 
. . 
Ram 255, OK 
 
(repeats entire sequence for passes 2 through 10) 
 
At conclusion of test or when Esc is received, SBE 26 displays: 
Ram test passed with no errors 
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Installing and Deploying SBE 26 
 
1. Install a dummy plug on the data I/O connector on the SBE 26 end cap: 

A. Lightly lubricate the inside of the dummy plug with silicone grease 
(DC-4 or equivalent). 

B. Standard Connector - Install the plug, aligning the raised bump on 
the side of the plug with the large pin (pin 1 – ground) on the SBE 26. 
Remove any trapped air by burping or gently squeezing the plug near 
the top and moving your fingers toward the end cap.     OR 
MCBH Connector – Install the plug, aligning the pins. 

C. Place the locking sleeve over the plug. Tighten the locking sleeve 
finger tight only. Do not overtighten the locking sleeve and do not 
use a wrench or pliers. 

 
2. If not using the SBE 4M conductivity sensor, install a dummy plug and 

locking sleeve on the SBE 26 3-pin bulkhead connector.  
Use the technique described in Step 1 for lubricating and burping a 
standard connector. 

 
3. (Optional) Install the SBE 4M conductivity sensor: 

A. Mount the SBE 4M to the SBE 26 with the supplied mounting 
bracket, positioning the SBE 4M connector towards the conductivity 
connector on the SBE 26. 

B. Connect the SBE 4M to the SBE 26 with the supplied cable, using the 
technique described in Step 1 for lubricating and burping, and then 
installing the locking sleeve. 

C. Remove the Tygon tubing that was looped end-to-end around the 
SBE 4M conductivity cell to keep the cell clean while stored. 

D. See Application Note 70: Installing Anti-Foulant Device Mounting 
Kit on SBE 4, 16, 19, and 21 Conductivity Cells, and Appendix V: 
AF24173 Anti-Foulant Device 

 
4. (Optional) Mount the SBE 26 in the Sea-Bird mounting fixture: 

A. Slide the mooring pin through the SBE 26 lift eye hole in the 
direction shown. 

B. Install the retaining ring in the lift eye hole recess, to hold the 
mooring pin to the SBE 26. Push part of the retaining ring into the 
recess, and hold it in place with a small tool (such as tweezers or 
small screwdriver). Using another pair of tweezers, work your way 
around the retaining ring, pushing it into the recess. 

C. Rotate the SBE 26 into the mounting fixture as shown. 
D. Screw the mooring pin into the mounting fixture. 

 

 

Mooring pin 

Install retaining ring  
in recess after  
inserting mooring pin 

Rotate SBE 26 into 
mounting fixture 

CAUTION: 
Do not use WD-40 or other 
petroleum-based 
lubricants, as they will 
damage the connectors. 

Note: 
Acquisition of conductivity data 
must be enabled by sending CY in 
SeatermW when programming the 
SBE 26 for deployment. 

Screw mooring 
pin into mounting 
fixture Mooring pin 
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Recovering SBE 26  
 
Rinse the SBE 26 with fresh water. See Section 10: Routine Maintenance and 
Calibration for (optional) conductivity cell cleaning and storage. 
 

WARNING! 
If the SBE 26 stops working while 
underwater, or shows other signs of 
flooding or damage, carefully 
secure it away from people until you 
have determined that abnormal 
internal pressure does not exist or 
has been relieved. Pressure housings 
may flood under pressure due to dirty 
or damaged o-rings, or other failed 
seals. When a sealed pressure 
housing floods at great depths and is 
subsequently raised to the surface, 
water may be trapped at the pressure 
at which it entered the housing, 
presenting a danger if the housing is 
opened before relieving the internal 
pressure. Instances of such flooding 
are rare. However, a housing that 
floods at 5000 meters depth holds  
an internal pressure of more than  
7000 psia, and has the potential to 
eject the end cap with lethal force.  
A housing that floods at 50 meters 
holds an internal pressure of more 
then 85 psia; this force could still 
cause injury. 
If you suspect the SBE 26 is flooded, 
point the SBE 26 in a safe direction 
away from people, and loosen the  
3 screws on the connector end cap 
about ½ turn. If there is internal 
pressure, the end cap will follow the 
screws out, and the screws will not 
become easier to turn. In this event, 
loosen 1 bulkhead connector very 
slowly, at least 1 turn. This opens an  
o-ring seal under the connector. Look 
for signs of internal pressure (hissing 
or water leak). If internal pressure is 
detected, let it bleed off slowly past the 
connector o-ring. Then, you can safely 
remove the end cap. 
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Uploading Data from Memory 
 
1. In Seasoft for Waves’ Run menu, select SeatermW.  

SeatermW appears. 
 
2. Select Configure in the Communications menu. The Configuration dialog 

box appears. Verify/modify the instrument, Comm port, and upload baud 
rate (9600, 19200, or 38400). Click OK. 

 
3. Select Connect in the Communications menu. The S> displays. This 

shows that correct communications between the computer and SBE 26 has  
been established. 
If the system does not respond with the S> prompt: 
• Select Connect again. 
• Verify the correct instrument and Comm port were selected. 
• Check cabling between the computer and SBE 26. 

 
4. If the SBE 26 is still logging, command the SBE 26 to stop logging by 

typing QL and pressing the Enter key.  
 
The SBE 26 responds: 

Stop logging (Y/N)?. 
Type y and press the Enter key. 
 
The SBE 26 responds: 

Are you sure (^Y/N).  
Hold down the Ctrl key and type y, and press the Enter key 

 
5. Display SBE 26 status information by clicking Status. The status response 

should indicate    logdata = no. 
 
6. Click Upload to upload stored data in a form that Seasoft for Waves’ data 

processing modules can use. SeatermW responds as follows: 
A. SeatermW sends the status (DS) command, displays the response, and 

writes the command and response to the upload file, with each line 
preceded by *. DS provides information regarding the number of 
samples in memory, sample intervals, etc. 

B. SeatermW sends the calibration coefficients (DC) command, displays 
the response, and writes the command and response to the upload file, 
with each line preceded by *. DC provides information regarding the 
sensor calibration coefficients. 

C. In the Save As dialog box, enter the desired upload file name and 
click OK. The upload file has a .hex extension. 

D. SeatermW sends the data upload command (DD, DE, or DA, 
depending on the upload baud rate you selected in the Configure 
dialog box in Step 2), and writes the Hex data to the upload file. The 
Status bar displays the progress of the upload, indicating the number 
of uploaded lines of data. 

 
7. Type QS and press the Enter key to put the SBE 26 in quiescent (sleep) 

state until ready to redeploy. 
 
8. Ensure all data has been uploaded by processing the data. See Section 6: 

Conversion into Tide and Wave Files – Convert Hex. 
 

Note: 
The SBE 26 communicates at  
7 data bits, 1 stop bit, and even 
parity, as documented on the 
instrument Configuration Sheet. 
The baud rate for general 
communication is always 9600. 
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Section 6: Conversion into Tide and Wave 
Files – Convert Hex 
 

Convert Hex converts uploaded raw hex (.hex) data into separate wave data 
(.wb) and tide data (.tid) files, with data in ASCII engineering units.  
Convert Hex must be run before further processing by Seasoft for Waves.  
 

 
Proceed as follows:  
 
1. In Seasoft for Waves’ Run menu, select Convert Hex. The dialog box 

looks like this: 

 
 

Enter information in the dialog box. Click Coefficients to enter / verify 
calibration coefficients for converting raw hex data to engineering units. 

Note: 
The first time you run Convert Hex, the 
Coefficients dialog box (Step 2 below) 
appears first. 

Note: 
SeasoftWaves.ini contains the location 
and file name of the last saved .psa file 
for each module. SeasoftWaves.ini is 
stored in %USERPROFILE%\ 
Local Settings\Apps\Sea-Bird  
(Example C:\Documents and Settings\ 
dbresko\Local Settings\Apps\Sea-Bird) 

.hex file uploaded from SBE 26 memory. 
Click Browse to search for file, or type in 
path and file name. 

Desired path and file names for output 
tide (.tid) and wave (.wb) file. Default 
paths and file names are same as input 
.hex file. If desired, type in path and file 
name to change it from default. 

Year logging started, in format 
yyyy (for example, 2000). 

Conversion 
status bar. 

.psa file contains 
calibration coefficients 
to convert raw hex data 
to engineering units. 

Correct start date and time in input data 
file, if required. Because of a leap year 
firmware bug in SBE 26, you may need to 
adjust SBE 26 Start time if either of 
following is true: 
• SBE 26 was deployed on February 29, 

or  
• Date and time were set before 

February 29 and SBE 26 was deployed 
after February 29. 
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2. The Coefficients dialog box looks like this: 
 

 
 

Make desired changes. Click OK to return to Convert Hex to Wave and 
Tide dialog box. 

 
 
 
 
 
 
 
 
 
 
 
3. Click Convert File to process the data. The Status bar at the bottom of the 

dialog box shows the progress of the calculations; when completed, the 
Status bar shows Finished conversion. 

 
 
 
 

Note: 
Older versions of Seasoft for 
Waves used a .ini file or a .cfg 
file for calibration coefficients. 
These files are not compatible 
with the current version of 
Seasoft for Waves. Re-enter 
the calibration coefficients in 
the .psa file. 

Save & Exit to save updated .psa file and 
return to Convert Hex to Wave and Tide 
dialog box.  
Open to select a different .psa file.  
Save As to save updated .psa file settings 
to a different .psa file. 

Slope and offset used to make small 
corrections for presure sensor drift 
between calibrations. Other pressure 
sensor calibration coefficients are 
hard coded into SBE 26 EPROM, and 
cannot be changed; view those 
coefficients with DC in SeatermW. 

Calibration 
coefficients  for 
optional 
conductivity 
sensor; must 
match calibration 
sheet. Temperature sensor calibration 

coefficients; must match calibration 
sheet. Other temperature sensor 
calibration coefficients are hard coded 
into SBE 26 EPROM, and cannot be 
changed; view those coefficients with 
DC in SeatermW. 
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Section 7: Tide Data Processing –  
Merge Barometric Pressure 
 

Merge Barometric Pressure reads in a tide (.tid) file (created with Convert 
Hex) and a barometric pressure (.bp) file, and subtracts barometric pressure 
from the tide data. The time in the files does not need to be aligned – Merge 
Barometric Pressure uses linear interpolation to align the data in time before 
subtracting barometric pressure. Merge Barometric Pressure can also convert 
tide pressure to water depth in meters, using average density and gravity. 
 
Both the input tide data and output adjusted file have a .tid extension. 
However, Merge Barometric Pressure will not process a .tid file that it has 
already processed, preventing a user from erroneously removing barometric 
pressure multiple times from the tide data. 
 
Remove barometric pressure as follows: 
 
1. In Seasoft for Waves’ Run menu, select Merge Barometric Pressure. The 

File Setup tab looks like this: 

 
Make the desired selections. 

Note: 
The barometric pressure (.bp) file is 
not supplied by Sea-Bird. It is created 
by the user, based on local barometric 
pressure data (such as that from a 
local weather station). See Input 
Barometric Pressure File Format 
below for the required data format. 

Note: 
SeasoftWaves.ini contains the location 
and file name of the last saved .psa file 
for each module. SeasoftWaves.ini is 
stored in %USERPROFILE%\ 
Local Settings\Apps\Sea-Bird  
(Example C:\Documents and Settings\ 
dbresko\Local Settings\Apps\Sea-Bird) 

File to store all information input in File 
Setup and Data Setup tabs. Open to 
select a different .psa file, Save or 
Save As to save current settings, or 
Restore to reset all settings to match 
last saved version. 

Directory and file names for tide (.tid) 
data and barometric pressure (.bp) 
data. Note that both .tid and .bp files 
must be in same directory, but they 
can have different names. Select to 
pick different files. 

Click Start Process to begin 
processing data. Status field 
shows Processing complete 
when done. 

Return to Seasoft for Waves window. 
• If Confirm Program Setup Change was selected in Options menu - If you made 

changes and did not Save or Save As, program asks if you want to save changes. 
• If Confirm Program Setup Change was not selected in Options menu - This says 

Save & Exit. If you do not want to save changes, click Cancel to exit. 

Directory and file name for output 
(.tid) data. Name append is added to 
output file name, before .tid 
extension. For example, if 
processing X.tid and March03.bp 
with a Name append of MinusBarP, 
output file is XMinusBarP.tid. 



Manual revision 017 Section 7: Tide Data Processing – Merge Barometric Pressure SBE 26 

 39 

2. Click on the Data Setup tab. The Data Setup tab looks like this: 

 
 
Make the desired selections and click Start Process to process the data. 
 
 
 

If selected, output .tid 
file contains water depth  
in place of pressure. 

Units in input barometric 
pressure (.bp) file –  
psia or millibars. 

Click Start Process to begin 
processing data. Status field on 
File Setup tab shows Processing 
complete when done. 

Return to Seasoft for Waves window. 
• If Confirm Program Setup Change was selected in Options menu - If you made 

changes and did not Save or Save As, program asks if you want to save changes. 
• If Confirm Program Setup Change was not selected in Options menu - This says 

Save & Exit. If you do not want to save changes, click Cancel to exit. 

Average density and gravity 
value to use to calculate water 
depth. Entry is ignored if you 
do not select Convert Pressure 
to Water Depth. 

Note: 
Merge Barometric Pressure adds 
descriptive headings to the pressure 
(or depth), temperature, and optional 
conductivity and salinity columns. The 
presence of headings in the .tid file 
indicates that it has been processed 
by Merge Barometric Pressure. See 
Appendix III: Data Formats. 
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Input Barometric Pressure File Format 
 
The required format for the input barometric pressure (.bp) file is: 
 

MM/DD/YY HH:MM:SS P 
MM/DD/YY HH:MM:SS P 

where 
MM = month DD = day YY = year 
HH = hour MM = minute SS = second 
P = barometric pressure in psia or millibars 
 (1 standard atmosphere = 14.7 psia or 1013.5 millibars) 

 
 

Merge Barometric Pressure Algorithm 
 
The linear interpolation algorithm is: 
 
 pbp = p0 + [(t - t0) * (p1 - p0) / (t1 - t0)] 
 corrected pressure = p - pbp 
where 

t = time of tide sample in .tid file 
p = pressure in .tid file at time t 
t0 = latest time in .bp file that is less than or equal to t 
p0 = barometric pressure at time t0 
t1 = earliest time in .bp file that is greater than or equal to t 
p1 = barometric pressure at time t1 
pbp = interpolated barometric pressure 

 
Depth is calculated as: 
 
 depth = corrected pressure / (average density * gravity) 
 
See Appendix VII: Pressure-to-Depth Conversion. 
 

 

Example .bp File: 
07/01/94  00:00:00  1015.5 
07/01/94  01:00:00  1016.4 
07/01/94  02:00:00  1017.3 

Note: 
The barometric pressure (.bp) file is 
not supplied by Sea-Bird. It is created 
by the user, based on local barometric 
pressure data (such as that from a 
local weather station). 
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Section 8: Wave Data Processing –  
Process Wave Burst Data and Create Reports 
 

Seasoft for Waves includes two wave data processing modules, which are 
covered in this section: 
 
• Process Wave Burst Data – Compute wave statistics from an input .wb 

wave burst file. Output .was statistics and results from auto-spectrum 
analysis, .rpt summary report, .wts statistics from surface wave zero 
crossing analysis, .wt surface wave time series, and .wss Fast Fourier  
Transform coefficients. 

 
• Create Reports - Create .r26 file with one line of surface wave time series 

and/or wave burst auto-spectrum statistics for each processed wave burst, 
from input .was and .wts files. 

 
 

Process Wave Burst Data 
 
Process Wave Burst Data computes wave statistics from an input .wb wave 
burst file (created in Convert Hex). Process Wave Burst Data outputs three (or 
optionally four or five) files: 
 
• Statistics and results from auto-spectrum analysis to a .was file. 
 
• Summary report from auto-spectrum analysis to a .rpt file. 

 
• Statistics from surface wave zero crossing analysis to a .wts file. 

 
• (optional) Surface wave time series to a .wt file 

 
• (optional) Fast Fourier Transform coefficients to a .wss file 
 

Note: 
See Appendix VI: Wave Theory and 
Statistics for details on the calculations 
made by Seasoft for Waves. 
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Process wave data as follows: 
 
 
 
 
 
 
1. In Seasoft for Waves’ Run menu, select Process Wave Burst Data.  

The File Setup tab looks like this: 

 
Make the desired selections. 
 

Note: 
SeasoftWaves.ini contains the location 
and file name of the last saved .psa file 
for each module. SeasoftWaves.ini is 
stored in %USERPROFILE%\ 
Local Settings\Apps\Sea-Bird  
(Example C:\Documents and Settings\ 
dbresko\Local Settings\Apps\Sea-Bird) 

File to store all information input in File 
Setup and Data Setup tabs. Open to 
select a different .psa file, Save or Save 
As to save current settings, or Restore 
to reset all settings to match last saved 
version. 

Directory and file name for wave (.wb) 
data. Select to pick different file. 

Click Start Process to begin 
processing data. Status field 
shows Processing complete 
when done. 

Return to Seasoft for Waves window. 
• If Confirm Program Setup Change was selected in Options menu - If you made 

changes and did not Save or Save As, program asks if you want to save changes. 
• If Confirm Program Setup Change was not selected in Options menu - This says 

Save & Exit. If you do not want to save changes, click Cancel to exit. 

Directory and file name for output data.  
Name append is added to output file name, 
before extension. For example, if processing 
X.wb with a Name append of Wave, output 
files are testWave.was, testWave.rpt, 
testWave.wts, etc. 
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2. Click on the Data Setup tab. The Data Setup tab looks like this: 

 
Make the desired selections and click Start Process to process the data. 

 
3. The Verify Setup dialog box appears: 

The dialog box summarizes data from the input .wb file and user inputs from the 
Data Setup tab, and shows calculated values for density, number of bands, band 
width, and frequency span. Review the summary; click Yes to process data. 

Outputting .wt and/or .wss files is 
optional; other file types (.was, .rpt, 
and .wts) are always output. 

High frequency cutoff for processing wave data, 
fmax, is smaller of: 
• frequency where (measured pressure / 

pressure at surface) < (minimum allowable 
attenuation / wave sample duration). 

• 1 / minimum period 
If getting high frequency noise in output, adjust 
minimum allowable attenuation and/or minimum 
period. Frequencies > fmax are not processed 
unless Use filter cutoff  is selected. 

Begin processing. Status field on File Setup 
tab shows Processing complete when done. 

Select number of wave bursts to process and 
number of wave bursts to skip at start of data file. 
Default - process all bursts. 

If not selected, all Fourier coefficients for 
frequencies >  fmax and < fmin are set to 0.  
If selected, filter ramps Fourier coefficients down 
to 0 for frequencies > fmax and < fmin. 

You may have used Plan Deployment to determine desired 
value; see Section 4: Pre-Deployment Planning –  
Plan Deployment and Battery and Memory Endurance. 

Low frequency cutoff fmin = (1 / maximum 
period). Frequencies < fmin are not processed 
unless Use filter cutoff is selected. 

Return to Seasoft for Waves window. 
• If Confirm Program Setup Change was selected in Options menu - If you made 

changes and did not Save or Save As, program asks if you want to save changes. 
• If Confirm Program Setup Change was not selected in Options menu - This says 

Save & Exit. If you do not want to save changes, click Cancel to exit. 

Average temperature and salinity used to 
calculate density, required for wave  
statistics algorithm. 

Hanning window 
suppresses spectral 
leakage that occurs 
when time series 
contains periodic 
signal that does not 
correspond to one of 
exact frequencies  
of Fast Fourier 
Transform. 
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Process Wave Burst Data Algorithm 
 
For each wave burst, Process Wave Burst Data performs an auto  
spectrum analysis: 
 
• Reads burst into an array. 
 
• Removes mean, saves mean value. 

 
• Uses mean value, and average water temperature and average salinity 

(input by user) to compute density. 
 

• Removes trend. 
 

• Makes array a power of two. 
 

• Applies Hanning window to suppress side-lobe leakage. 
 

• Adjusts scale factor to account for tapering by Hanning window. 
 

• Fast Fourier Transforms to create raw spectral estimates of  
subsurface pressure. 

 
• Computes maximum frequency to process. 

 
• Sets Fourier coefficients greater than maximum frequency or less than 

minimum frequency to 0; or 
(if Use filter cutoff is selected) applies a filter that ramps the Fourier 
coefficients down to 0 for frequencies greater than maximum frequency or 
less than minimum frequency 

 
• Saves Fourier coefficients. 

 
• Band averages raw spectral estimates to create auto-spectrum. 

 
• Applies dispersion transfer function to band center frequencies. 

 
• Calculates wave statistics from auto-spectrum: variance, energy, 

significant wave height, and significant period. 
 
 
Using the saved (non-band-averaged) Fourier coefficients, Process Wave 
Burst Data performs a surface wave zero crossing analysis: 
 
• Applies dispersion transfer function to each frequency. 

 
• Inverse Fast Fourier Transforms to create surface wave time series. 

 
• Applies inverse Hanning window and adjusts scale factor. 

 
• Zeroes all elements where inverse Hanning factor is greater than 10. 

 
• Performs zero crossing analysis of surface wave time series to create an 

array of individual waves and their corresponding periods. 
 

• Sorts wave array in ascending order. 
 

• Calculates wave statistics from surface wave time series:  
average wave height, average period, maximum wave height,  
significant period, significant wave height H1/3 , H1/10 , H1/100. 
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Create Reports: Summarize Wave Data 
 

Create Reports creates a file containing one line of surface wave time series 
and/or wave burst auto-spectrum statistics for each processed wave burst. The 
input .wts file contains surface wave time series statistics and the input .was 
file contains wave burst auto spectrum statistics (these files are created in 
Process Wave Burst Data). The output .r26 file format is user-defined and can 
contain one or more of the following variables: 
 

 Variable Column Label 

From Surface Wave 
Time Series Statistics 

(.wts) File 

Time Time 
burst number burst 

pressure sensor depth depth 
number of waves nwaves 

variance var-wts 
Energy energy-wts 

average wave height avgheight 
average wave period avgper 

maximum wave height maxheight 
significant wave height swh-wts 
significant wave period swp-wts 

H1/10 H1/10 
H1/100 H1/100 

From Wave Burst  
Auto-Spectrum Statistics 

(.was) File 

variance var-was 
energy energy-was 

significant wave height swh-was 
significant wave period swp-was 
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Proceed as follows: 
 
 
 
1. In Seasoft for Waves’ Run menu, select Create Reports. The File Setup 

tab looks like this: 

 
 
Make the desired selections. 

 
 

Note: 
SeasoftWaves.ini contains the location 
and file name of the last saved .psa file 
for each module. SeasoftWaves.ini is 
stored in %USERPROFILE%\ 
Local Settings\Apps\Sea-Bird  
(Example C:\Documents and Settings\ 
dbresko\Local Settings\Apps\Sea-Bird) 

File to store all information input in File 
Setup and Data Setup tabs. Open to 
select a different .psa file, Save or Save 
As to save current settings, or Restore 
to reset all settings to match last saved 
version. 

Directory and file name for wave (.was 
and .wts) data. Select to pick different file. 
Note that both .was and .wts files must be 
selected, even if you intend to output 
variables from only one of the files. Files 
must be in same directory, and must have 
same name (before extension). 

Click Start Process to begin 
processing data. Status field 
shows Processing complete 
when done. 

Return to Seasoft for Waves window. 
• If Confirm Program Setup Change was selected in Options menu - If you made 

changes and did not Save or Save As, program asks if you want to save changes. 
• If Confirm Program Setup Change was not selected in Options menu - This says 

Save & Exit. If you do not want to save changes, click Cancel to exit. 

Directory and file name for output data.  
Name append is added to output file name, 
before extension. For example, if processing 
X.was and X.wts with a Name append of 
Wave, output file is XWave.r26. 
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2. Click on the Data Setup tab. The Data Setup tab looks like this: 

 
Make the desired selections. 

 

If selected, output .r26 file contains labels 
above data columns (labels match 
variable names in Select Variables  
dialog box). 

Click Start Process to begin 
processing data. Status field 
shows Processing complete 
when done. 

Click to bring up a list of variables. 
See Step 3 below. 

Separate each variable in output 
.r26 file with a space, tab,  
semi-colon, or colon. 

If selected, output .r26 file contains a 
descriptive text header that includes input 
file name and path, wave integration  
time, number of points in burst, height of  
SBE 26 above bottom, and water density. 

Output date and time as Julian days, 
hh:m,m:ss (hours, minutes, seconds), 
or dd mmm yyyy hh:mm:ss (day, 
month, year, hours, minutes, seconds). 

Return to Seasoft for Waves window. 
• If Confirm Program Setup Change was selected in Options menu - If you made 

changes and did not Save or Save As, program asks if you want to save changes. 
• If Confirm Program Setup Change was not selected in Options menu - This says 

Save & Exit. If you do not want to save changes, click Cancel to exit. 
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3. Click Select Variables. The Select Variables dialog box looks like this: 

 
Make the desired selections and click OK to return to the Create Reports 
data setup tab. 

 
 
4. Click Start Process to process the data. 
 
 
 
 
 

 

Click a variable and click Add to add it to list of output 
variables on left. 
• If you select energy, significant period, significant 

wave height, or variance, Create Reports requires you 
to select whether to calculate variable from wave burst 
auto-spectrum (.was) or wave time series (.wts). 
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Section 9: Data Plotting – Plot Data 
 

Plot Data displays and plots data from files with a .tid, .wb, .was, .wts, or .wt 
file extension. Plot Data: 
• Plots up to five variables on one plot, with one X axis and up to  

four Y axes. 
• Zooms in on plot features. 
• Sends plots to a printer, saves plots to the clipboard for insertion in 

another program (such as Microsoft Word), or saves plots as graphic files 
in bitmap, metafile, or JPEG format. 

 
In Seasoft for Waves’ Run menu, select Plot Data. Each tab of the dialog box is 
described below, as well as options for viewing, printing, and saving plots. 
 

File Setup Tab 
 
The File Setup tab defines the Program Setup file, input data file(s), and output 
plot file name. The File Setup tab looks like this: 

 

Note: 
SeasoftWaves.ini contains the location 
and file name of the last saved .psa file 
for each module. SeasoftWaves.ini is 
stored in %USERPROFILE%\ 
Local Settings\Apps\Sea-Bird  
(Example C:\Documents and Settings\ 
dbresko\Local Settings\Apps\Sea-Bird) 

File to store all information input in 
File, Plot, and Axis tabs. Open to 
select a different .psa file, Save or 
Save As to save current settings, 
or Restore to reset all settings  
to match last saved version.  

Click Start Process to begin 
processing data. Status field 
shows Processing complete  
when done. 

Default directory and file name (can be changed while viewing plot) for outputting 
graphic file in .wmf, .jpg, or .bmp format. Default file name is set to match input file 
name, with additional characters added before extension, in order listed below: 
• Name append, to allow user to add descriptive information to file name. 
• Plot type (as for Auto Spectrum, tts for Tide Time Series, ws for Wave Statistics, or 

wts for Wave Time Series). 
• Wave burst number for types that have a plot for each wave burst 
For example, if processing X.tid, X.wb, X.was, X.wts, and X.wt with a Name Append 
of Color and outputting .jpg files, output file names are XColorAs-0.jpg,  
XColorAs-1.jpg, etc. (Auto Spectrum: 1 file for each selected wave burst); 
XColorTts.jpg (Tide Time Series); XColorWs.jpg (Wave Statistics); XColorWts-0.jpg, 
XColorWts-1.jpg, etc. (Wave Time Series: 1 file for each selected wave burst). 

Return to Seasoft for Waves window. 
• If Confirm Program Setup Change was selected in Options menu - If you made 

changes and did not Save or Save As, program asks if you want to save changes. 
• If Confirm Program Setup Change was not selected in Options menu - This says 

Save & Exit. If you do not want to save changes, click Cancel to exit. 

Directory and file names for input 
data files (.tid, .wb, .was, .wts, and 
/ or .wt files). All files must be in 
same directory and have same 
name before extension. Select to 
pick different files. 
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Plot Setup Tab 
 
The Plot Setup tab defines the plot type, data to be included, and plot layout 
(title, color, font, grid lines, etc.). The Plot Setup tab looks like this: 

 
 

Return to Seasoft for Waves window. 
• If Confirm Program Setup Change was 

selected in Options menu - If you made 
changes and did not Save or Save As, 
program asks if you want to save changes. 

• If Confirm Program Setup Change was not 
selected in Options menu - This says Save & 
Exit. If you do not want to save changes, click 
Cancel to exit. 

Symbol plotting 
frequency  
(0 = least frequent,  
9 = most frequent),  
if Monochrome plot 
selected. If too frequent, 
symbols create illusion 
of very thick line, 
making details difficult 
to see. 

Available selections dependent on input 
file types selected on File Setup tab: 
• Wave Time Series 
• Tide Time Series 
• Auto Spectrum 
• Wave Statistics 

Plot Font type and Font size (small, 
medium, or large). Plot Data displays 
example of font type to right of 
selection. List of fonts depends on what 
fonts are installed on your computer. 

• User input Plot title. 
• User selected Title color. 
• Select Add file name to title to add 

input data file name to user input title. 
For example, for a plot title Wave Time 
Series with input file X.wb, if you select 
Add file name to title, title is  
Wave Time Series, X.wb. 

Grid lines (none, horizontal and vertical, horizontal, 
vertical). Grid style (solid, dotted, or dashed line), 
and whether to place Grid in front of plotted data. 

Click Start Process to begin 
processing data. Status field 
shows Processing complete 
when done. 

• Mark data points: Mark 
each individual data point 
with a dot, and connect 
dots. If not selected, Plot 
Data just draws a 
continuous line between 
data points. 

• Show plot shadow: Create 
shadow effect to bottom 
and right of axes. 

Space between axes and 
maximum and minimum plotted 
values, if Auto range selected 
on Axis tabs.  
For 0%, maximum and 
minimum values plot on axes. 

Select number of wave 
bursts or tide scans to 
process and number to 
skip at start of data file. 
Default is to process  
all data. 

• Monochrome plot: Substitute black 
lines with symbols for colors (colors 
and symbols defined on Axis tabs). 
Allows you to set up axes with colors 
for viewing on screen, and then 
switch to black lines with symbols for 
black and white printing. 

• Plot symbols only: Mark each 
individual data point with a symbol, 
and do not connect symbols with a 
line (symbols defined on Axis tabs). 

• Show line legends: Show legends 
below plot title. Legend indicates line 
color or symbol, as applicable. 

Size (small, medium, large) of symbol 
for each variable, if Monochrome plot or 
Plot symbols only selected. 

Inside Background Color defines color 
within axes. Outside Background Color 
defines color outside axes. 
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X Axis Tab 
 
Click on the X Axis tab. The X Axis tab defines the plot style as well as the  
X axis variable, scale, and line type. 
The X Axis tab looks like this for Wave Time Series, Tide Time Series, or 
Wave Statistics: 

 
 

Selection dependent on Plot type selected 
on Plot Setup tab: 
• Wave Time Series – time (seconds) 
• Tide Time Series – date and time 
• Wave Statistics – burst number or  

date and time 

Select to label axis with variable 
name as listed in drop down 
Variable list, or enter Custom label 
for axis. 

• Auto range  - Plot Data selects 
axis Minimum and Maximum 
values, number of Major 
divisions on axis, and number  
of Minor divisions between 
Major divisions. 

• Auto divisions - Plot Data 
selects number of major 
divisions on axis, and number of 
minor divisions between major 
divisions. User selects axis 
Minimum and Maximum values. 

Any values that fall outside user-
selected Minimum to Maximum 
range will plot at minimum or 
maximum, as applicable. 

Click Start Process to begin 
processing data. Status field 
shows Processing complete 
when done. 

• Overlay – overlay plot for all Y axis 
variables on one plot, or  

• Stacked - create a separate plot for 
each Y axis variable, with plots 
stacked vertically above each other. 

Return to Seasoft for Waves window. 
• If Confirm Program Setup Change was 

selected in Options menu - If you made 
changes and did not Save or Save As, 
program asks if you want to save changes. 

• If Confirm Program Setup Change was not 
selected in Options menu - This says Save & 
Exit. If you do not want to save changes, click 
Cancel to exit. 

Select desired line type, color, and 
symbol. Selection of color or 
monochrome plot, and inclusion of 
symbols in plot, is made on Plot 
Setup tab, and applies to all axes. 
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The X Axis tab looks like this for Auto Spectrum: 

 
 

Select desired line type, color, 
and symbol. Selection of color 
or monochrome plot, and 
inclusion of symbols in plot, is 
made on Plot Setup tab, and 
applies to all axes. 

Select to label axis with variable 
name as listed in drop down 
Variable list, or enter a Custom 
label for axis. 

• Auto range - Plot Data selects 
axis Minimum and Maximum 
values, number of Major 
divisions on axis, and number  
of Minor divisions between 
Major divisions. 

• Auto divisions: - Plot Data 
selects number of major 
divisions on axis, and number of 
minor divisions between major 
divisions. User selects axis 
Minimum and Maximum values. 

Any values that fall outside user-
selected Minimum to Maximum 
range will plot at minimum or 
maximum, as applicable. 

Return to Seasoft for Waves window. 
• If Confirm Program Setup Change was 

selected in Options menu - If you made 
changes and did not Save or Save As, 
program asks if you want to save changes. 

• If Confirm Program Setup Change was not 
selected in Options menu - This says Save & 
Exit. If you do not want to save changes, click 
Cancel to exit. 

Click Start Process to begin 
processing data. Status field 
shows Processing complete 
when done. 

• Overlay 2D – 2D plot of frequency and 
energy density 

• Overlay 3D – 3D plot of frequency, 
energy density, and either burst 
number or date and time 

Selection dependent on Plot type 
selected on Plot Setup tab: 
• Auto Spectrum – frequency (Hz) 

If selected, confidence intervals 
and burst parameters display in 
text at right of a 2D plot. 
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Y Axis Tab 
 
The Y Axis tabs define the Y axis variables, scales, and line types. 
 

 
 
 

Select desired line type, 
color, and symbol. Selection 
of color or monochrome 
plot, and inclusion of 
symbols in plot, is made on 
Plot Setup tab, and applies 
to all axes. 

Select to label axis with variable 
name as listed in drop down 
Variable list, or enter a Custom 
label for axis. 

• Auto range  - Plot Data selects 
axis Minimum and Maximum 
values, number of Major 
divisions on axis, and number  
of Minor divisions between 
Major divisions. 

• Auto divisions - Plot Data 
selects number of major 
divisions on axis, and number 
of minor divisions between 
major divisions. User  
selects axis Minimum and 
Maximum values. 

Any values that fall outside user-
selected Minimum to Maximum 
range will plot at minimum or 
maximum, as applicable. Return to Seasoft for Waves window. 

• If Confirm Program Setup Change was 
selected in Options menu - If you made 
changes and did not Save or Save As, 
program asks if you want to save changes. 

• If Confirm Program Setup Change was not 
selected in Options menu - This says Save & 
Exit. If you do not want to save changes, click 
Cancel to exit. 

Click Start Process to begin 
processing data. Status field 
shows Processing complete 
when done. 

Selection dependent on Plot type 
selected on Plot Setup tab. 

Include this axis in plot. Plot Data 
can plot 1 X and up to 4 Y axes.  
At least 1X and 1 Y variable  
is required, so this selection  
is available only on  
Y Axis 2, 3, and 4.  
Note: If you deselect an axis, all 
axes numbered above that axis 
are automatically deselected. 
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Viewing and Outputting Plots 

 
The Plot Data View window’s menus are described below: 
 
Output – Output the plot to printer, clipboard, or a file. 
• Print – Print the single plot that is displayed on screen. In the dialog box, 

select printer, orientation, color, etc.; these selections override selections 
you made in Plot Data and in the Plot Data View Options menu. 

• File – Output to file the single plot that is displayed on screen, in the 
selected format (.wmf, .jpg, or .bmp). In the dialog box, select the desired 
directory and output file name; these selections override selections you 
made in Plot Data and in the Plot Data View Options menu. 

• Clipboard – Output to the clipboard the single plot that is displayed on 
screen, in the selected format (.wmf, .jpg, or .bmp). The selected format 
overrides the selection you made in the Plot Data View Options menu. 

• Print Range (for wave time series and auto spectrum plots) – Print plots 
for several wave bursts for the series that is displayed on screen. In the 
dialog box, select the wave burst print range. Orientation and size are as 
selected in the Plot Data View Options menu. Plots output to your 
system’s default printer; to output to a different printer you must select a 
new default printer before you select Print Range. 

• File Range (for wave time series and auto spectrum plots) – Output to file 
the plots for several wave bursts for the series that is displayed on screen, 
in the selected format (.wmf, .jpg, or .bmp). In the dialog boxes, select the 
wave burst file output range, and the desired directory and output file 
name. Directory and file name selections override selections you made in 
Plot Data and in the Plot Data View Options menu. 

 

Zoom in to enlarge 
details by clicking and 
dragging to select a 
rectangular area.  
Plot Data zooms in on 
that area. You can 
zoom in several times 
before reaching 
program limits. Undo 
zoom by selecting Undo 
Zoom in View menu. 

Use View menu or keyboard 
Arrow, Home, or End keys to 
switch between plots for each 
wave burst. 

Double click on an axis or axis label (wave 
amplitude, time, etc.), and appropriate Axis tab 
appears, allowing you to make changes and 
reprocess data with new plotting parameters. 

Double click on plot title, and 
Plot Setup tab appears, 
allowing you to make 
changes and reprocess data. 

Notes: 
• The first wave burst is labeled 0. 
• To change the default printer in 

Windows XP: Click Start / Printers 
and Faxes. A list of printers 
installed on your system appears, 
with a check mark next to the 
default printer. Right click on the 
desired printer, and select Set as 
Default Printer. 
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Options – Sets up defaults for how the plot is output to the printer, file,  
or clipboard. 
 
• Print –  

 Orientation – landscape, portrait, or (printer) driver default.  
If driver default is selected, orientation is determined by the default 
for the printer you select in Output / Print (if printing a single plot)  
or the system default printer (if printing multiple plots using  
Output / Print Range). 

 Print full page – If selected, scale plot to fit 8 ½ x 11 inch page.  
If not selected, Size determined by -  
Plot Data View Dimensions – plot dimensions as shown on screen. 
Values Entered Below – Units, Width, and Height entered here. 

 
• File –  

 Data format – Metafile (.wmf), Jpeg (.jpg), or Bitmap (.bmp). 
 Size determined by - 

Plot Data View Dimensions – plot dimensions as shown on screen. 
Values Entered Below – Units, Width, and Height entered here. 

 
• Clipboard –  

 Data format – Metafile (.wmf), Jpeg (.jpg), or Bitmap (.bmp). 
 Size determined by - 

Plot Data View Dimensions – plot dimensions as shown on screen. 
Values Entered Below – Units, Width, and Height entered here. 

 
View – Sets up viewing options. 
 
• First Burst, Last Burst, Next Burst, Prior Burst, Go to Burst (applicable to 

wave time series and auto spectrum plots) – Switch the plot on screen to a 
different wave burst. 

 
• Undo Zoom –Return the plot to the original ranges specified on the Axis 

tabs. Undo Zoom is grayed out unless you have zoomed in (by clicking 
and dragging to select a rectangular area) to enlarge details. 

 
• Set Zoomed Ranges – Substitute the current zoomed ranges of the plot for 

the Minimum and Maximum plot ranges on the Axis tabs. This allows you 
to save the ranges of the zoomed view, so you can go to exactly the same 
view the next time you run Plot Data. Set Zoomed Ranges is grayed out 
unless you have zoomed in (by clicking and dragging to select a 
rectangular area) to enlarge details. 
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Section 10: Routine Maintenance  
and Calibration 

 
This section reviews corrosion precautions, connector mating and 
maintenance, battery replacement, pressure sensor maintenance, optional 
conductivity cell storage and cleaning, and sensor calibration. The accuracy of 
the SBE 26 is sustained by the care and calibration of the sensors and by 
establishing proper handling practices. 
 
 

Corrosion Precautions 
 
Rinse the SBE 26 with fresh water after use and prior to storage. 
 
For both the plastic and titanium housing, all exposed metal is titanium  
(the plastic housing has a titanium end cap). No corrosion precautions are 
required, but avoid direct electrical connection of the titanium to dissimilar 
metal hardware. 
 
The optional SBE 4M conductivity cell has an aluminum or titanium housing. 
The aluminum housing has a ring-shaped zinc anode. Check the anode 
periodically to verify that it is securely fastened and has not been dissolved. 
 
 

Connector Mating and Maintenance 
 
Clean and inspect connectors, cables, and dummy plugs before every 
deployment and as part of your yearly equipment maintenance. Inspect 
connectors that are unmated for signs of corrosion product around the pins, 
and for cuts, nicks or other flaws that may compromise the seal. 
 
When remating: 
 
1. Lightly lubricate the inside of the dummy plug/cable connector with 

silicone grease (DC-4 or equivalent). 
 
2. Standard Connector - Install the plug/cable connector, aligning the 

raised bump on the side of the plug/cable connector with the large pin  
(pin 1 - ground) on the SBE 26. Remove any trapped air by burping or 
gently squeezing the plug/connector near the top and moving your fingers 
toward the end cap.    OR 
MCBH Connector – Install the plug/cable connector, aligning the pins. 

 
3. Place the locking sleeve over the plug/cable connector. Tighten the 

locking sleeve finger tight only. Do not overtighten the locking sleeve 
and do not use a wrench or pliers. 

 
Verify that a cable or dummy plug is installed for each connector on the  
system before deployment. 
 
 

CAUTION: 
Do not use WD-40 or other 
petroleum-based lubricants, as they 
will damage the connectors. 

Note: 
See Application Note 57: Connector 
Care and Cable Installation. 
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Battery Replacement 
 
The SBE 26 uses 9 alkaline D-cells (Duracell MN1300, LR20), dropped into 
the battery compartment. 
 
Leave the batteries in place when storing the SBE 26 to prevent depletion of 
the back-up lithium batteries by the real-time clock. Even exhausted main 
batteries power the clock (90 microamperes) almost indefinitely. If the SBE 26 
is to be stored for long periods, replace the batteries yearly to prevent 
battery leakage (which could damage the SBE 26). 

 
1. Remove the battery end cap (end cap without connectors): 

A. Wipe the outside of the end cap and housing dry, being careful to 
remove any water at the seam between them. 

B. Remove the end cap by rotating counter-clockwise (use a wrench on 
the white plastic bar if necessary). 

C. Remove any water from the O-ring mating surfaces inside the 
housing with a lint-free cloth or tissue. 

D. Put the end cap aside, being careful to protect the O-ring from 
damage or contamination. 

 
2. Remove the battery cover plate from the housing: 

A. Remove the three Phillips-head screws and washers from the battery 
cover plate inside the housing. 

B. The battery cover plate will pop out. Put it aside. 
 
3. Turn the SBE 26 over and remove the batteries. 
 
4. Install the new batteries, with the + terminals against the flat battery 

contacts and the - terminals against the spring contacts. 
 

5. Reinstall the battery cover plate in the housing: 
A. Align the battery cover plate with the housing. The posts inside the 

housing are not placed symmetrically, so the cover plate fits into the 
housing only one way. Looking at the cover plate, note that one screw 
hole is closer to the edge than the others, corresponding to the post 
that is closest to the housing. 

B. Reinstall the three Phillips-head screws and washers, while pushing 
hard on the battery cover plate to depress the spring contacts at the 
bottom of the battery compartment. The screws must be fully 
tightened, or battery power to the circuitry will be intermittent. 

 
6. Check the battery voltage at BAT + and BAT - on the battery cover plate. 

It should be approximately 13.5 volts. 
 
7. Reinstall the battery end cap: 

A. Remove any water from the O-rings and mating surfaces with a lint-
free cloth or tissue. Inspect the O-rings and mating surfaces for dirt, 
nicks, and cuts. Clean or replace as necessary. Apply a light coat  
of o-ring lubricant (Parker Super O Lube) to O-rings and  
mating surfaces. 

B. Carefully fit the end cap into the housing and screw the end cap into 
place. Use a wrench on the white plastic bar to ensure the end cap is 
tightly secured. 

 
 

Alkaline D-cell  
(MN1300, LR20) 

Unthread cap by 
rotating counter-
clockwise 

Remove Phillips-head  
screws and washers 
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Pressure Sensor Maintenance 
 
The pressure fitting – which includes a pressure port fitting, external tube, and 
polyurethane bladder bag – is filled with silicone oil at the factory. The oil 
transmits hydrostatic pressure via internal, capillary tubing to the pressure 
sensor inside the instrument, and prevents corrosion that might occur if  
the sensor diaphragm was exposed to water. The bladder bag is vacuum  
back-filled. 
 
The bladder bag can develop tears and leaks over time. If the fitting has been 
damaged, or investigation due to poor data shows that the bag has torn, replace 
the fitting and bag and refill the oil. Sea-Bird highly recommends that you 
send the SBE 26 back to the factory for this repair, as it is difficult to 
completely remove all air from the system in the field, resulting in 
potential pressure errors. However, if you must do the repair to meet a 
deployment schedule, contact Sea-Bird to purchase the needed parts. 
 
Parts required: 

Part 
Number Description Quantity 

30551 Pressure port bladder bag 2 * 
50025 Pressure sensor oil refill kit ** 1 
50029 Nylon capillary assembly 2 * 
30002 Swagelock, nylon, NY-200-1-OR 2 * 

30521 Syringe, 60 cc, DURR #899069, MFG #309663 
(18 gage needle ground) 1 

* Only 1 is required, but we recommend that you purchase a spare in case you 
have difficulty with the procedure. 
** If you have a bell jar, use it to de-gas the oil in the oil refill kit. 
 

1. Securely mount the SBE 26 vertically (connector end cap up). 
 
 

2. Remove the 3 Phillips-head screws attaching the pressure tube guard 
to the lifting eye. Remove the pressure tube guard and the pressure 
cover that is under it. 

 
 
 
 
 
 
 
 
 
 
 
 
 

3. Remove the fitting from the end cap with a 9/16 inch wrench. Discard 
the fitting, tubing, and pressure bag. 

 
 
 
 
 
 
 

Pressure sensor port 

Connector End Cap 

Tube 

Lifting eye 

Pressure 
tube guard 

Lifting eye 

Pressure 
tube guard 

Pressure 
cover 

Pressure 
bag 

Fitting 
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4. Clean the pressure bag cavity in the lift eye and the removed pressure 
tube guard and pressure cover, removing all residue/grit. Ensure that 
the holes in each corner of the pressure bag cavity in the lift eye are 
free of obstructions. 

 
5. Clean the sensor end cap, being careful to remove any residue/grit 

near the pressure port. 
 

6. From the 50025 pressure sensor oil refill kit, fill the small syringe 
with the supplied oil. Fill the pressure port, forming a meniscus on 
the surface of the end cap. Keep the SBE 26 in the vertical position 
for at least 30 minutes before proceeding, to allow any bubbles in the 
internal plumbing to rise to the surface. Add oil from the small 
syringe as necessary to maintain the meniscus. 

 
 
 
 
 
 

7. Install the supplied capillary fitting (50029) in the pressure port. 
 

A. As the fitting is installed, oil should rise the length of the tube 
and overflow. Wipe up the excess oil with a paper towel. 

 
B. Gently tighten the lower portion of the fitting with a 9/16 inch 

wrench - DO NOT OVERTIGHTEN. 
 

C. Remove the upper portion of the capillary fitting and tube using a 
7/16 inch wrench. Store it for possible use another time. 

 
 
 

8. Using the small syringe, add oil to the lower portion of the fitting, 
forming a meniscus. 

 
 
 
 
 
 
 

9. Fill the large syringe (30521) ¼ full with oil.  
 

A. Thread the tube from the pressure bag (30551) through the 
Swagelock fitting (30002), and install the pressure bag tube over 
the needle. 

 
B. Pull the plunger back on the syringe, drawing a vacuum on the 

pressure bag until it is completely flat. Maintain the vacuum on 
the bag. 

 
C. Hold the syringe vertically with the bag down and slowly release 

the plunger, allowing the vacuum to be released. The bag should 
slowly fill with oil. There is enough oil in the bag when the bag 
looks like a small pillow. It is very important that there are no air 
bubbles in the pressure bag; you may have to perform this step 
several times to ensure that there are no bubbles. 

Add oil, 
forming a 
meniscus 

Meniscus 

7A. Oil 
should 
overflow 
from top of 
tube 

7B. Tighten 
with 9/16 
inch wrench 

7C. Remove 
with 7/16 
inch wrench 

9C. Fill 
bag with 
oil; check  
for air 
bubbles 

9B. Draw 
vacuum on 
bag until flat 

9A. Thread 
tube through 
fitting and over 
needle 

Pressure 
bag cavity 

Pressure port 

CAUTION: 
Do not put a brush or any object in the 
pressure port. Doing so may damage or 
break the pressure sensor. 
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10. After the bag is filled, gently remove the tube from the needle, 
keeping the bag at or below the level of the end of the tube to prevent 
air from entering the bag. Maintaining gentle pressure on the bag to 
keep the oil at the end of the tube and prevent air from entering the 
bag, insert the end of the tube into the lower portion of the fitting on 
the end cap and screw the Swagelok fitting down, using a 7/16 inch 
wrench. Oil should overflow from the fitting, preventing air from 
entering the bag; the overflow should stop when the fitting is 
tightened. When completed, the bag should be approximately ½ full 
of oil and contain no air. 

 
 
 
 
 
 
 
 
 

11. Install the pressure bag in the pressure bag cavity. Place the tubing in 
the indent, going counter-clockwise from the bag to the fitting. 

 
 
 
 
 
 
 
 
 
 
 
 
 

12. Reinstall the pressure cover, pressure tube guard, and 3 Phillips-head 
screws, being careful not to pinch the tubing or the bag. 

 
 
 
 
 
 
 
 
 
 
 
 
 

13. Log data on the SBE 26, and download the data. Compare the 
pressure readings to a local barometer. A pinched or overfilled bag 
will give pressure readings that are higher that the correct values. 

 
 
 
 

Pressure 
bag 

Tighten with 
7/16 inch 
wrench 

Maintain gentle 
pressure on  
bag 

Lifting eye 

Pressure 
tube guard 

Pressure 
cover 
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Conductivity Cell Maintenance 
 
The SBE 26’s optional conductivity cell (SBE 4M) is shipped dry to prevent 
freezing in shipping. Refer to Application Note 2D: Instructions for Care and 
Cleaning of Conductivity Cells for conductivity cell cleaning procedures and 
cleaning materials. 
 
• The Active Use (after each cast) section of the application note  

is not applicable to the SBE 4M, which is intended for use as a  
moored instrument. 

 
 

 

CAUTIONS: 
• Do not put a brush or any object 

inside the conductivity cell to 
dry it or clean it. Touching and 
bending the electrodes can 
change the calibration. Large 
bends and movement of the 
electrodes can damage the cell. 

• Do not store the SBE 4M with 
water in the conductivity cell. 
Freezing temperatures (for 
example, in Arctic environments or 
during air shipment) can break the 
cell if it is full of water. 
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Sensor Calibration 
 
Sea-Bird sensors are calibrated by subjecting them to known physical 
conditions and measuring the sensor responses. Coefficients are then 
computed, which may be used with appropriate algorithms to obtain 
engineering units. The pressure, temperature, and optional conductivity 
sensors on the SBE 26 are supplied fully calibrated, with coefficients printed 
on their respective Calibration Certificates (in manual). 
 
We recommend that the SBE 26 be returned to Sea-Bird for calibration. 
 
 
Quartz Pressure Sensor Calibration 
 
The pressure sensor is capable of meeting the SBE 26’s error specification 
with some allowance for aging and ambient-temperature induced drift. The 
pressure sensor is supplied with coefficients derived from a calibration 
performed over temperature (0 - 125 °C). When used in the quartz sensor 
temperature model (as incorporated in Sea-Bird software), these coefficients 
reflect the initial calibration of the sensor. 
 
The pressure sensor coefficients are hard coded into the SBE 26. These can be 
viewed using DC in SeatermW, but cannot be changed by command. 
However, values for slope (default = 1.0) and offset (default = 0.0) can be 
entered in Convert Hex’s Coefficient Configuration dialog box to make small 
corrections for sensor drift. Techniques are provided below for making small 
corrections using the slope and offset terms by comparing SBE 26 pressure 
output to: 
• Readings from a barometer 
• Readings from a dead-weight pressure generator – provides more accurate 

results, but requires equipment that may not be readily available 
 
Before using either of these procedures, allow the SBE 26 to equilibrate in a 
reasonably constant temperature environment for at least 5 hours before 
starting. Pressure sensors exhibit a transient change in their output in response 
to changes in their environmental temperature. Sea-Bird instruments are 
constructed to minimize this by thermally decoupling the sensor from the body 
of the instrument. However, there is still some residual effect; allowing  
the SBE 26 to equilibrate before starting will provide the most accurate 
calibration correction. 
 
 
Calculating Offset using a Barometer 
 
1. Place the SBE 26 in the orientation it will have when deployed. 
2. In SeatermW, connect to the SBE 26. 
3. Send FR to display the pressure and pressure sensor temperature 

compensation frequencies. Click Stop to end the test. 
4. Compute pressure in psia from the frequency with the formula shown on 

the calibration sheet. 
5. Compare the SBE 26 output to the reading from a good barometer. 

Calculate Offset = barometer reading – SBE 26 reading. 
6. Enter the calculated offset (positive or negative) in Convert Hex’s 

Coefficients Configuration dialog box. 
 

Offset Correction Example 
Pressure measured by barometer is 1010.50 mbar. Pressure calculated from SBE 26 pressure frequency is 14.06 psia. 
Convert barometer reading to psia using relationship: mbar * 0.01 dbar/mbar * 1 psia / 0.689476 dbar = psia 
Barometer reading = 1010.50 mbar * 0.01 / 0.689476 = 14.66 psia           Offset = 14.66 – 14.06 = +0.60 psia 
Enter offset in Convert Hex’s Coefficient Configuration dialog box. 

 

Note: 
Although the pressure sensor 
manufacturer can re-calibrate 
the pressure sensor by 
duplicating the original 
procedures, the sensor must be 
removed from the SBE 26, the 
cost is relatively high, and lead 
times can be considerable. 
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Calculating Slope and Offset using a Dead-Weight Pressure Generator 
 
Tests show that room-temperature-derived slope and offset corrections to the 
initial quartz calibration can account for long-term drift to within less than 
0.01% of the sensor’s full scale range. To perform this correction: 
 
1. Use a suitable dead-weight pressure generator to subject the sensor to 

increments of known pressures. The end cap’s 5/16-24 straight thread 
permits mechanical connection to a pressure source. Use a fitting  
that has an o-ring face seal, such as Swagelok-200-1-OR.  
See Application Note 12-1: Pressure Port Oil Refill Procedure & Nylon 
Capillary Fitting Replacement. 

2. In SeatermW, connect to the SBE 26. 
3. Send FR to display the pressure and pressure sensor temperature 

compensation frequencies. Click stop to end the test. 
4. Compute pressure from the frequencies with the formula shown on the 

calibration sheet. 
5. Enter the calculated slope and offset (positive or negative) in Convert 

Hex’s Coefficient Configuration dialog box. 
 
 

Pressure Slope and Offset Correction Example 
A 45 psia sensor has drifted and its responses are low, as shown below: 
Actual Pressure (psia) Indicated Pressure (psia) 
 0.000 -0.057 
 9.000 8.939 
 18.000 17.936 
 27.000 26.932 
 36.000 35.929 
 45.000 44.925 
Linear regression (best straight-line fit)   pcorrected = (pindicated * slope) + offset 
yields slope = 1.00039381 and offset = 0.057. Enter these correction coefficients, originally set to 
1.0 and 0.0 respectively, in Convert Hex’s Coefficient Configuration dialog box. 
 
 
 
 
 
 

Temperature Sensor Calibration 
 
The primary source of temperature sensor calibration drift is the aging of the 
thermistor element. Sensor drift is usually a few thousandths of a degree 
during the first year, and less in subsequent intervals. Sensor drift is not 
substantially dependent upon the environmental conditions of use, and — 
unlike platinum or copper elements — the thermistor is insensitive  
to shock. 
 
The temperature sensor calibration certificate shows the following coefficients: 
• AI and XI are hard coded in the SBE 26 EPROM and are used to 

calculate the raw hex data (Note that some temperature sensor calibration 
sheets list g and x instead of AI and XI. Verify that g = AI and x = XI.). 
View these coefficients with DC in SeatermW. 

• Z and RH are used internally only. 
• A0, A1, and A3 are used in Convert Hex to convert the raw temperature 

data to engineering units. View and/or modify these coefficients in 
Convert Hex’s Coefficient Configuration dialog box. 
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Conductivity Sensor Calibration 
 
The optional SBE 4M conductivity sensor incorporates a fixed precision 
resistor in parallel with the cell. When the cell is dry and in air, the sensor’s 
electrical circuitry outputs a frequency representative of the fixed resistor. This 
frequency is recorded on the Calibration Certificate and should remain stable 
(within 1 Hz) over time. 
 
The conductivity sensor calibration certificate shows the following coefficients: 
g, h, i, j, Cpcor, and Ctcor. View and/or modify these coefficients in Convert 
Hex’s Coefficient Configuration dialog box. 
• Cpcor makes a correction for the highly consistent change in dimensions 

of the conductivity cell under pressure. The default is the compressibility 
coefficient for borosilicate glass (-9.57e-08). Some sensors fabricated 
between 1992 and 1995 (serial numbers between 1100 and 1500) exhibit a 
compression that is slightly less than pure borosilicate glass. For these 
sensors, the (hermetic) epoxy jacket on the glass cell is unintentionally 
strong, creating a composite pressure effect of borosilicate and epoxy.  
For sensors tested to date, this composite pressure coefficient ranges from 
-9.57e-08 to -6.90e-08, with the latter value producing a correction to 
deep ocean salinity of 0.0057 PSU in 5000 dbars pressure (approximately  
0.001 PSU per 1000 dbars). Before modifying Cpcor, confirm that the 
sensor behaves differently from pure borosilicate glass. Sea-Bird can test 
your cell and calculate Cpcor. Alternatively, test the cell by comparing 
computed salinity to the salinity of water samples from a range of depths, 
calculated using an AutoSal. 

 
Enter values for slope (default = 1.0) and offset (default = 0.0) in Convert 
Hex’s Coefficient Configuration dialog box to make small corrections for 
conductivity sensor drift between calibrations: 

Corrected conductivity = (slope * computed conductivity) + offset 
where 
slope = true conductivity span / instrument conductivity span 
offset = (true conductivity – instrument reading) * slope; measured at 0 S/m 
 

Conductivity Slope and Offset Correction Example 
At true conductivity = 0.0 S/m, instrument reading = -0.00007 S/m 
At true conductivity = 3.5 S/m, instrument reading = 3.49965 S/m 
Calculating the slope and offset: 
Slope = (3.5 – 0.0) / (3.49965 - [- 0.00007]) = + 1.000080006 
Offset = (0.0 - [-0.00007]) * 1.000080006 = + 0.000070006 

 
The primary mechanism for calibration drift in conductivity sensors is the 
fouling of the cell by chemical or biological deposits. Fouling changes the cell 
geometry, resulting in a shift in cell constant (slope of the calibration curve), 
typically resulting in lower conductivity readings over time. Offset error  
(error at 0 S/m) is usually due to electronics drift, and is typically less than 
± 0.0001 S/m per year. Because offsets greater than ± 0.0002 S/m are a 
symptom of sensor malfunction, Sea-Bird recommends that drift corrections 
be made by assuming no offset error, unless there is strong evidence to the 
contrary or a special need. 
 
The most important determinant of long-term sensor accuracy is the 
cleanliness of the cell. We recommend that the conductivity sensors be 
calibrated before and after deployment, but particularly when the cell has been 
exposed to contamination by oil slicks or biological material. 
 
 

Note: 
See Application Note 31 for 
computation of slope and offset 
correction coefficients from pre- 
and post-cruise calibrations 
supplied by Sea-Bird or from 
salinity bottle samples taken at 
sea during profiling. 
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Section 11: Troubleshooting 
 
This section reviews common problems in operating the SBE 26, and provides 
the most common causes and solutions. 
 
 

Problem 1: Unable to Communicate with SBE 26 
 
The S> prompt indicates that communications between the SBE 26 and 
computer have been established. Before proceeding with troubleshooting, 
attempt to establish communications again by clicking Connect in SeatermW 
or hitting the Enter key several times. 
 
Cause/Solution 1: The I/O cable connection may be loose. Check the cabling 
between the SBE 26 and computer for a loose connection. 
 
Cause/Solution 2: The instrument and/or Comm port may not have been 
entered correctly in SeatermW. Select Configure in the Communications 
menu, and verify the settings. 
 
Cause/Solution 3: The I/O cable may not be the correct one. The I/O cable 
supplied with the SBE 26 permits connection to the DB-9P input connector on 
a standard RS-232 interface. 
• SBE 26 Pin 1 (large pin) goes to DB-9 pin 5 (ground) 
• SBE 26 pin 2 (counter-clockwise from large pin) goes to DB-9 pin 3 
• SBE 26 pin 3 (opposite the large pin) goes to DB-9 pin 2 
 
Cause/Solution 4: If attempting to communicate with the SBE 26 after you 
started logging, the SBE 26 may be collecting a wave burst (indicated by 
sequences of a’s and d’s on the display). You cannot communicate with the 
SBE 26 while it is collecting a wave burst. Try to establish communications 
again a few seconds after the characters stop. 
 
Cause/Solution 5: In rare cases, the program that controls the SBE 26’s 
microprocessor can be corrupted by a severe static shock or other problem. 
This program can be initialized by using the reset switch. Proceed as follows 
to initialize: 
1. Open the battery end cap and remove the batteries (see Battery 

Replacement in Section 10: Routine Maintenance and Calibration). 
2. There is a toggle reset switch on the battery compartment bulkhead, which 

is visible after the batteries are removed. The switch is used to disconnect 
the internal lithium batteries from the electronics. Set the switch to the 
reset position for at least 5 minutes. 

3. Reinstall or replace the batteries, and close the battery end cap. 
4. Establish communications with the SBE 26 (see Section 5: SBE 26 Setup, 

Installation, and Data Upload - SeatermW for details). Initialize RAM 
(IR), reset the date and time (ST), and re-enter all the setup parameters. 

 
 

Note: 
Using the reset switch erases the 
SBE 26 memory – all logged data  
in memory is lost and all user-
programmable parameters (date and 
time, sampling scheme, etc.) are 
reset to default values. 
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Problem 2: Nonsense or Unreasonable Data 
 
The symptom of this problem is an uploaded file that contains unreasonable 
values (for example, values that are outside the expected range of the data). 
 
Cause/Solution 1: An uploaded data file with unreasonable values for 
pressure, temperature, or conductivity may be caused by incorrect calibration 
coefficients in the instrument .psa file. View the coefficients by clicking the 
Coefficients button in Convert Hex. Verify that the calibration coefficients in 
the instrument .psa file match the instrument Calibration Certificates. 
 
 

. 
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Glossary 
 
Battery and Memory Endurance – Seasoft for Waves module for 
calculating power endurance and memory endurance for a user-specified 
sampling scheme. 
 
Convert Hex – Seasoft for Waves module for converting uploaded .hex file 
into separate wave (.wb) and tide (.tid) files.  
 
Create Reports – Seasoft for Waves module for outputting one line of surface 
wave time series and/or wave burst auto-spectrum statistics for each processed 
wave burst.  
 
Fouling – Biological growth in the conductivity cell during deployment. 
 
Merge Barometric Pressure – Seasoft for Waves module for removing 
barometric pressure from tide data.  
 
PCB – Printed Circuit Board. 
 
Plan Deployment – Seasoft for Waves module for calculating the ratio of 
pressure amplitude measured by the instrument to pressure amplitude at the 
surface, and predicting number of frequency bands calculated, width of each 
band, and frequency span. 
 
Plot Data – Seasoft for Waves module for plotting wave and tide data. 
 
Process Wave Burst Data– Seasoft for Waves module for computing wave 
statistics. 
 
SEAGAUGE – High-accuracy wave and tide recorder with a quartz pressure 
sensor, precision thermometer, and optional SBE 4M conductivity sensor. 
 
Seasoft for Waves – Modular Win 95/98/NT/2000/XP program for pre-
deployment planning, communication with the SBE 26 for setup, uploading of 
data from the SBE 26, separation of the raw data into separate wave and tide 
files, removal of barometric pressure from tide data, statistical analysis, and data 
plotting. Modules include Plan Deployment, Battery and Memory Endurance, 
SeatermW, Convert Hex, Merge Barometric Pressure, Process Wave Burst Data, 
Create Reports, and Plot Data. 
 
SeatermW – Seasoft for Waves module for communication with the  
SBE 26 for setup and uploading of data from the SBE 26. 
 
TCXO – Temperature Compensated Crystal Oscillator. 
 
Triton X-100 – Reagent grade non-ionic surfactant (detergent), used for 
cleaning the conductivity cell. Triton can be ordered from Sea-Bird, but should 
also be available locally from chemical supply or laboratory products 
companies. Triton is manufactured by Avantor Performance Materials 
(www.avantormaterials.com/commerce/product.aspx?id=2147509608).  . 
 

 
 



Manual revision 017 Appendix I: Command Summary SBE 26 

 68 

Appendix I: Command Summary 
 

CATEGORY COMMAND DESCRIPTION 

Status 

DS Display status and setup parameters. 

DC 
Display pressure sensor and temperature sensor 
calibration coefficients that are hard coded into 
SBE 26 EPROM. 

Setup 

IR     * Initialize memory, which destroys all logged 
data in memory. 

ST Set real-time clock date and time. 

SI 

Set sampling intervals and parameters: 
• Tide interval 
• Wave burst after every N tide measurements 
• Wave samples/burst – for most accurate 

results, this number should be a power of 2 
(2, 4, 8, 16, 32, 64, 128, etc.) 

• Number of 0.25-second periods to  
integrate waves 

Cx 
x=Y: Enable conductivity logging (use if 
optional SBE 4M conductivity sensor included). 
x=N: Do not. 

LWx 
x= wait interval (milliseconds) after each line of 
data. Normally set to 0; increase for very slow 
computers. Range 0 – 65535. 

QS Enter quiescent (sleep) state. Main power turned 
off, but memory retention unaffected. 

Logging GL     * Start logging, overwriting any logged data  
in memory. 

QL     * Quit logging. 

Data Upload 

DDb,e Display raw data from memory in Hex from 
sample b to e at 9600 baud. 

DEb,e Display raw data from memory in Hex from 
sample b to e at 19200 baud. 

DAb,e Display raw data from memory in Hex from 
sample b to e at 38400 baud. 

Diagnostic 

TM     * Memory test, which destroys all data  
in memory. 

TE     * Extended memory test, which destroys all data 
in memory. 

FR 

Measure and display pressure frequency, 
pressure temperature compensation frequency, 
and conductivity sensor frequency. SBE 26 runs 
continuously during test, drawing current. Press 
Esc key or Stop to stop test. 

VR 

Measure and display (main battery 
voltage/5.0161), (lithium battery voltage/3.873), 
raw thermistor voltage, raw large reference 
resistor voltage, and raw small reference resistor 
voltage. SBE 26 runs continuously during test, 
drawing current. Press Esc key or Stop to  
stop test.  

 
 

Note: 
Commands followed by * alter 
SBE 26 memory and prompt the 
user twice before executing (* is 
not part of the command). To 
execute the command, type Y 
and press Enter key in response 
to message Y/N. Then hold 
down Ctrl key and type y, and 
press Enter key in response to 
are you sure ^Y/N. Any other 
responses abort the command. 
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Appendix II: Sample Timing 
 

Note the following, as illustrated in the example below: 
 
• When GL is sent to start logging, the SBE 26 sleeps for one tide interval 

before starting logging. 
• The SBE 26 integrates the pressure sensor output over the entire tide 

interval, calculating and storing an average pressure for that time period. 
• Actual calculation and storing of tide data is delayed by two tide intervals. 

For example, as the SBE 26 begins tide measurement #3, it is 
simultaneously calculating and storing the data from tide measurement #1. 

• Wave burst sampling is done after the calculation and storing of the 
applicable measurement. For example, if the SBE 26 is set up to sample a 
wave burst after every four tide measurements, the first wave burst occurs 
after the calculation and storing of data from tide #4. 

• Time required for each wave burst must be less than  
(tide interval - 30 seconds). If the user setup does not meet this requirement, 
the SBE 26 reduces the number of measurements in the wave burst to meet 
the requirement. 

 

 
 

 
 

Example:  
Tide interval = 60 minutes. 
Wave burst of 128 measurements at 0.5 seconds/measurement (128 x 0.5 = 64 seconds) after ever 4 tide measurements. 
User sends GL at 12 pm. 
 

Time Begin Tide Measurement 
# 

Begin to Calculate and Store Data 
from Tide Measurement # 

Begin Wave Burst 
# 

12:00 (user sends GL) 
13:00 #1 - - 
14:00 #2 - - 
15:00 #3 #1 - 
16:00 #4 #2 - 
17:00 #5 #3 - 
18:00 #6 #4 - 
19:00 #7 #5 #1 
20:00 #8 #6 - 
21:00 #9 #7 - 
22:00 #10 #8 - 
23:00 #11 #9 #2 
00:00 #12 #10 - 
01:00 #13 #11 - 
02:00 #14 #12 - 
03:00 #15 #13 #3 
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Appendix III: Data Formats 
 

This appendix provides detailed information on data format for each file type. 
 

Extension Description 
.hex Raw Hex data uploaded from SBE 26 memory using SeatermW. 

.tid 
Tide measurements only, created from .hex file by Convert Hex. Also, 
file output by Merge Barometric Pressure, which removes barometric 
pressure from an input .tid file. 

.bp 
Barometric pressure data, used by Merge Barometric Pressure to 
remove barometric pressure from the tide data (.tid) file. See Section 7: 
Tide Data Processing – Merge Barometric Pressure for .bp format. 

.wb Wave measurements only, created from .hex file by Convert Hex. 

.was Statistics and results from auto-spectrum analysis, created by Process 
Wave Burst Data. 

.rpt Summary report, created by Process Wave Burst Data. 

.wss 
Fast Fourier Transform coefficients, created by Process Wave Burst 
data if Output FFT coefficients to .wss file is selected. Details not 
provided. 

.wts Statistics from surface wave zero crossing analysis, created by Process 
Wave Burst Data. 

.wt Surface wave time series, created by Process Wave Burst Data 
if Output surface wave time series to .wt file is selected. 

.r26 
File containing one line of surface wave time series and/or wave burst 
auto-spectrum statistics for each processed wave burst, created by 
Create Reports. 

 

Hex Data Format (.hex extension)  
 
A .hex file contains raw hexadecimal data uploaded from SBE 26 memory 
using SeatermW’ Upload. The beginning of a sample .hex data file follows: 
 
* Sea-Bird SBE 26 Data File: 
* FileName = 23.HEX 
* Software Version 4.0.b.20 
*ds 
*SBE 26 SEAGAUGE V4.1d  SN 335, 06/06/02  13:09:14.439 
*pressure sensor: serial number = 36285,  range = 45 psi 
*clk = 32767.843   iop = 63   vmain = 13.1   vlith = 5.9 
*last sample:   p = 13.3193   t = 1.407 
* 
*tide measurement interval = 5 min 
*measure waves after every 1 tide samples 
*1024 wave samples/burst at 4.00 scans/second 
* 
*tide samples/day = 288.000 
*wave bursts/day = 288.000 
*memory endurance = 0.052 days 
*recorded tide measurements = 27 
*recorded wave bursts = 27 
* 
*conductivity = YES 
*logdata = NO 
*dc 
*Paroscientific Digiquartz calibration coefficients: 
*    U0 =  5.881116 
*    Y1 =  -3971.433 
*    Y2 =  -9778.307 
*    Y3 =  0.000 
*    C1 =  170.09370 
*    C2 =  22.880490 
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*    C3 =  -230.10930 
*    D1 =  0.0589810 
*    D2 =  0.0000000 
*    T1 =  24.31375 
*    T2 =  0.5175830 
*    T3 =  17.76489 
*    T4 =  0.00000 
*    T5 =  0.00000 
*    M = 9532.5 
*    B = 4766.3 
* 
*Temperature coefficients: 
*    Z = -49405.0 
*    RH = 46995.0 
*    AI = 268135.0 
*    XI = -8.879 
*S> 
FFFFFFFD (flag beginning of tide parameters) 
04C6B570 (time of beginning of first tide sample) 
012C0001 (tide integration period, wave integration period) 
FFFFFFFE (flag end of tide parameters) 
5ED8C726 (tide data – pressure and temperature) 
000ACF6B (conductivity data, only present if enabled) 
00000000 (flag beginning of wave burst) 
04C6B7C8 (wave burst time) 
A7578200 (pressure temperature compensation frequency) 
9A12CB9A (wave burst pressure data) 
12C89A12 ( " ) 
CB9A12CB ( " ) 
9A12C89A ( " ) 
12CB9A12 ( " ) 
CB9A12C8 ( " ) 
FFFFFFFF (flag end of wave burst) 
5ED8C726 (tide data) 
000ACF6B (conductivity data, only present if enabled) 
 

• Beginning lines - * flags header. Header lines contain (in order): 
 Input file name 
 Software version used to upload the data 
 SBE 26 response to display status (DS) command 
 SBE 26 response to display calibration coefficients (DC) command 

 
• Following lines - Data follows, with eight characters per line, followed by 

a carriage return and line feed. Data is described below. 
 
 
Tide Parameters and Data 
 
Data (lines after the *S>) is described below: 
 
• First line - FFFFFFFD; flags the start of tide parameters. 
• Second line - Start time (seconds since January 1, 1989) of integration of 

first tide sample. 
• Third line - First four characters is tide sample interval (seconds);  

last four characters is number of 0.25-second periods to integrate  
wave samples. 

• Fourth line - FFFFFFFE; flags the end of tide parameters. 
• Fifth and following lines – Fifth line is a tide record (pressure and 

temperature). For tide record, first 19 bits are pressure number and last  
13 bits are temperature voltage. If conductivity logging is enabled (CY), a 
tide record is followed by a conductivity record.  
All lines that are not flags, tide parameters, or wave burst data are tide 
(pressure and temperature) or conductivity records. 
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Convert Hex converts the raw hex data to pressure, temperature, and 
(optional) conductivity in engineering units when the data is separated into 
tide and wave burst files. The tide data conversions are described below: 
 
Tide Record (pressure and temperature) 
 
pressure = [ slope correction * (pressure number - B) / M ] + offset correction 
where 
• slope and offset corrections are read from the Convert Hex calibration 

coefficients (.psa) file. 
• M and B are scaling parameters that depend on pressure sensor range, and 

are stored in EPROM: 
Pressure Sensor Range (psia) M B 

23 21845 0 
30 15887.5 7943.8 
45 9532.5 4766.3 

100 4766.3 2383.2 
200 2383.1 1191.6 
300 1588.8 794.4 
400 1191.6 595.8 
1000 476.6 238.3 
2000 238.3 119.2 
3000 158.9 79.5 
6000 79.4 39.7 

10000 47.7 23.9 
 
temperature voltage = (temperature number - 4095) / 819 
 
Temperature is computed as follows: 
 
LR = ln ( [AI / (temperature voltage - XI) ] - 15000.0) 
temperature = [ 1.0 / (A0 + A1 * LR + A3 * LR3) ] - 273.15 
where  
• AI and XI are hard coded in the SBE 26 EPROM and are read from the 

.hex file header. 
• A0, A1, and A3 are read from the Convert Hex calibration coefficients 

(.psa) file. 
 

Example: tide record = 49E6A726 hex = 0100 1001 1110 0110 1010 0111 0010 0110 binary 
 
The first 19 bits are 0100100111100110101 binary = decimal 151349. 
For this example, assume 45 psia pressure sensor, slope correction = 1.0, and offset correction = 0. 
pressure = [ slope correction * (151349 – 4766.3) / 9532.5 ] + offset correction = 15.3772 psia 
 
The last 13 bits are 0011100100110 binary = decimal 1830. 
temperature voltage = (1830 - 4095) / 819 = -2.766 volts 
For this example, assume A0 = 1.0e-3, A1 = 2.3e-4, A3 = 1.5e-7, XI = -8.745, and AI = 271800. 
LR = ln ( [271800 / (-2.766 - -8.745) ] - 15000.0) = 10.32414 
temperature = [1.0 / ( 1.0e-3 + 2.3e-4 * 10.32414 + 1.5e-7 * 10.32414 3) ] - 273.15  
                    = [1.0 / 3.5396e-3] - 273.15 = 9.366 °C 

 
 
 
Conductivity Record 
 
conductivity frequency (Hz) = conductivity number / 256 
 
Conductivity frequency is converted to conductivity using the coefficients and 
equation found on the calibration certificate for the sensor. These coefficients are 
read from the Convert Hex calibration coefficients (.psa) file. 
 
Example: 
Conductivity number = 000ACF6B hex =708459 decimal 
Conductivity frequency = 708459 / 256 = 2767.418 Hz 

Note: 
Some temperature sensor 
calibration sheets list g instead of 
AI and x instead of XI. 
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Wave Burst Data 
 
• First wave burst line = 00000000; flags the start of a wave burst. 
• Second wave burst line = Start time (seconds since January 1, 1989) of 

wave burst. 
• Third wave burst line = First 24 bits is pressure temperature 

compensation frequency; last 8 bits are 0. 
• Fourth and following wave burst lines = Next n groups of 24 bits are 

pressure frequencies, where n is number of wave samples per burst. 
• Last wave burst line = FFFFFFFF; flags the end of a wave burst. 
 
Convert Hex automatically makes the conversion of the raw hex data to 
pressure when the data is separated into tide and wave burst files. The 
conversions are described below: 
 
Pressure temperature compensation frequency = PTCF = 24 bits / 64 

 
Pressure frequency = PF = 24 bits / 256 
Pressure period = T = 1 / PF 
 
Pressure is computed as follows: 
 
U = [ (1.0 / PTCF) * 1000000 ] - U0 
(note that U0 may be listed as X0 on the calibration sheet) 
 
C = C1 + (C2 * U) + (C3 * U2) 
 
D = D1 + D2    but D2 = 0, so       D = D1 
 
T0 = (T1 + T2 * U + T3 * U2 + T4 * U3+ T5 * U4) / 1000000   But T5 = 0 , so 
T0 = (T1 + T2 * U + T3 * U2 + T4 * U3) / 1000000  
 
W = 1.0 - (T0 * T0 / T * T) 
 
pressure = slope correction * [ C * W * (1.0 - D * W) ] + offset correction 
 
where  
• U0, C1, C2, C3, D1, T1, T2, T3, and T4 are hard coded in the SBE 26 

EPROM and are read from the uploaded .hex file header. 
• Slope and offset corrections are read from the Convert Hex calibration 

coefficients (.psa) file. 
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Tide Data Format (.tid extension)  
 

A .tid file is created from the .hex file in Convert Hex. A sample tide data 
(.tid) file is shown below: 
 
1   11/13/92 10:27:16   14.8125    22.102   3.55682    23.909 
2   11/13/92 10:28:16   15.0086    14.818   3.48032    27.844 
3   11/13/92 10:29:16   15.0836    11.242   3.07901    26.714 
4   11/13/92 10:30:16   15.1536     8.951   3.07101    28.376 
5   11/13/92 10:31:16   15.2267     7.225   3.06788    29.772 
 
• Column 1 = Tide measurement number 
• Columns 2 and 3 = Date and time of beginning of tide measurement 
• Column 4 = Measured pressure in psia 
• Column 5 = Measured water temperature in °C 
• Column 6= Measured conductivity in S/m 
• Column 7 = Calculated salinity in PSU 
 
If Merge Barometric Pressure has been run on the .tid file to remove the effect 
of barometric pressure, the output .tid file contains descriptive column 
headings. The presence of headings in the .tid file indicates that it has been 
processed by Merge Barometric Pressure. Additionally, Merge Barometric 
Pressure has the ability to replace the pressure in the fourth column with 
calculated water depth. See Section 7: Tide Data Processing – Merge 
Barometric Pressure for details, and for the required data format for the 
barometric pressure (.bp) file to input in Merge Barometric Pressure. 
 
 

Wave Burst Data Format (.wb extension)  
 

A .wb file is created from the .hex file in Convert Hex. A sample wave burst 
data file is shown below: 
 
SBE 26 SEAGAUGE 
*    0   39714178    1.00  32 
 21.344801     21.344801     21.250858     21.058917 
 20.948967     20.986165     21.101858     21.188864 
 21.204989     21.157996     21.094862     21.030808 
 21.030145     21.133848     21.241456     21.250286 
 21.139034     21.006829     20.983782     21.064104 
 21.176656     21.267824     21.261526     21.168517 
 21.102853     21.075775     21.035574     21.002877 
 21.046280     21.145214     21.204416     21.199654 
*    1   39724978    1.00  32 
 22.135044     22.135044     22.203410     22.258581 
 22.272837     22.277849     22.284841     22.250777 
 22.173778     22.123603     22.151409     22.223522 
 22.288892     22.341974     22.368526     22.333153 
 22.246305     22.182725     22.175729     22.182845 
 22.194884     22.236219     22.252728     22.185787 
 22.119699     22.198516     22.385685     22.516203 
 22.506578     22.397684     22.269475     22.156724 
 
• First line - * flags beginning of data for a wave burst. Line contains  

(in order): 
 Wave burst number 
 Start of wave measurement (seconds since January 1, 1989) 
 Wave integration period (seconds) 
 Number of points in wave burst 

 
• Second and following lines (until next line with *) -  

Measured pressures in psia, with four values per line 

Note: 
If conductivity logging is not 
enabled (conductivity = NO in the 
status display), the sixth and 
seventh columns are not included 
in the .tid file. 
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Wave Burst Auto-Spectrum Statistics (.was extension)  
 

A .was file is created from the .wb file in Process Wave Burst Data. A sample 
wave burst Auto-Spectrum statistics file is shown below: 
 

SBE 26 SEAGAUGE 
*  0  39714178  1.00 1024  10   5.666  4.466  1024.211  90  0.637  1.843 
 51 5.371094e-003 9.765625e-003 5.9946e-003 6.0210e+001 1.0732e+001 3.0970e-001 
 3.091334e-003   3.298001e-003   2.160857e-003   7.776975e-004 
 5.304750e-003   3.731420e-003   1.790720e-002   2.439886e-002 
 8.326155e-002   1.082657e-001   5.056803e-002   5.299359e-002 
 2.502890e-002   2.332787e-002   2.122386e-002   1.846813e-002 
 3.559706e-002   3.633030e-002   2.943071e-002   8.796323e-003 
 8.000838e-003   4.111465e-003   2.995502e-003   6.887020e-003 
 2.995481e-003   4.263404e-003   1.317504e-003   3.054346e-003 
 1.688730e-003   2.141096e-003   1.688405e-003   3.960159e-003 
 1.314685e-003   1.714741e-003   1.393692e-003   1.332473e-003 
 3.300501e-004   5.239898e-004   3.741254e-004   1.336304e-003 
 5.561366e-004   6.184441e-004   8.887792e-004   4.510226e-004 
 5.383913e-004   4.866397e-004   1.003825e-003   5.819744e-004 
 7.742675e-004   1.622945e-003   9.336277e-004 
*  1  39724978  1.00 1024  10  6.378  5.178  1024.211  90  0.637  1.843 
 51 5.371094e-003 9.765625e-003 6.2661e-003 6.2937e+001 1.0732e+001 3.1663e-001 
 2.399138e-003   4.958530e-003   5.970532e-003   5.397915e-003 
 3.676770e-003   2.406614e-002   1.292470e-002   2.224974e-002 
 4.823480e-002   1.086449e-001   7.481066e-002   8.684431e-002 
 1.948858e-002   2.912741e-002   3.741619e-002   2.336472e-002 
 2.254591e-002   1.218159e-002   1.780615e-002   4.395502e-003 
 9.833613e-003   3.936535e-003   5.881464e-003   4.571996e-003 
 5.443738e-003   4.163474e-003   3.601095e-003   3.585647e-003 
 5.531514e-003   1.835893e-003   1.114426e-003   3.934834e-003 
 2.174772e-003   1.469032e-003   1.335585e-003   9.147523e-004 
 6.760068e-004   8.808380e-004   5.716856e-004   7.181183e-004 
 6.005655e-004   4.775679e-004   1.299268e-003   3.855911e-004 
 4.464863e-004   4.614029e-004   6.163178e-004   8.327592e-004 
 1.575676e-003   1.628755e-003   4.645250e-003 

 
 
• First line - * flags the beginning of the data for a wave burst. Line 

contains (in order): 
 Wave burst number 
 Start of wave burst (seconds since January 1, 1989) 
 Wave integration time (seconds) 
 Number of points in the wave burst 
 Number of spectral estimates for each frequency band 
 Water depth (meters) 
 Pressure sensor depth (meters) 
 Density (kg/m3) 
 Chi-squared confidence interval (percent) 
 Multiplier for Chi-squared lower bound 
 Multiplier for Chi-squared upper bound 

 
• Second line contains (in order): 

 Number of frequency bands calculated 
 Frequency of first frequency band (Hz) 
 Interval between frequency bands (delta f) (Hz) 
 Total variance (meters2) 
 Total energy (Joules / meters2) 
 Significant period (seconds) = frequency band with greatest variance 
 Significant wave height (meters) = 4 × sqrt (total variance) 

 
• Third and following lines (until next line with *) -  

Values (beginning with the first frequency) for the Auto-Spectral density 
function <Gaa>. Units are meters2 / Hz. To obtain the variance (m2) in a 
frequency interval δf (Hz), multiply the value of <Gaa> by δf. 
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Wave Burst Auto-Spectrum Report (.rpt extension)  
 

A .rpt file is created from the .wb file in Process Wave Burst Data. A sample 
wave burst Auto-Spectrum report file is shown below: 
 
surface wave processing summary: 
file = apr12sp.wb 
temperature = 15.000 
salinity = 33.000 
density = 1024.431 
number of points per wave burst = 1028 
sample period = 1.00 sec 
burst # 1: 
    mean pressure = 21.207 psia 
    instrument depth = 4.466 meters 
    total water depth = 5.666 meters 
auto-spectrum: 
    10 spectral estimates per band 
    51 bands calculated 
    each band is 0.010 Hz wide 
    frequency span = 0.005  to  0.492 Hz 
 
MM/DD HH:MM SIG.HT SIG.PER                  ENERGY (CM.SQ.) 
             (CM)  (SEC)   22+  20  17 15  13  11  9   7   5   3 
--------------------------------------------------------------------------- 
04/05 15:42   31    11      1   0   0   2   2  19  13  10  10   3 
04/05 18:42   32    11      2   2   0   1   2  15  18  11   7   4 
04/05 21:42   46     3      2   2   0   2   3   7  12  15   8  82 
04/06 00:42   39     9      1   3   0   2   5  10  13  14   8  39 
04/06 03:42   41    18      3  13   0   6   2   6  17  11   9  41 
04/06 06:42   45    10      4   2   0   8   3  10  21  12  13  56 
04/06 09:42   49     8      2   2   0  11   2  13  23  27  29  42 
04/06 12:42   57    16      1   5   0  28   5   6  28  17  43  71 
04/06 15:42   61    16      1   5   0  59   3   9  27  18  60  50 
04/06 18:42   67    16      6   2   0  72  37   9  17  12  52  70 
 
The energy (centimeters squared) is the sum of the variance over the indicated 
frequency band: 
 
• The 9 second wave period column is the sum of the variances where the 

frequency is between 1/10 Hz and 1/8 Hz. 
• The 20 second wave period column is the sum of the variances where the 

frequency is between 1/22 Hz and 1/18 Hz. 
• The 22+ second wave period is the sum of the variances of all the frequencies 

less than 1/22 Hz. 
 

Significant period = 1 / (band averaged frequency with the greatest variance) 
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Surface Wave Time Series Statistics (.wts extension)  
 

A .wts file is created from the .wb file in Process Wave Burst Data. A sample 
surface wave time series statistics file is shown below: 
 

SBE 26 SEAGAUGE 
*  0  39714178  1.00  1024   109   5.666      4.466    1024.431 
  6.860774e-003 6.892497e+001 1.972292e-001 7.431193e+000 
  6.293907e-001 3.115848e-001 9.138889e+000 4.114119e-001 6.293907e-001 
*  1  39724978  1.00  1024   112   6.377      5.177    1024.431 
  6.632170e-003 6.662836e+001 1.914052e-001 7.223214e+000 
  4.505061e-001 3.078597e-001 9.000000e+000 3.902955e-001 4.505061e-001 

 
• First line - * flags the beginning of the data for a wave burst. Line 

contains (in order): 
 Wave burst number 
 Start of wave burst (seconds since January 1, 1989) 
 Wave integration time (seconds) 
 Number of points in the wave burst 
 Number of individual waves found 
 Water depth (meters) 
 Pressure sensor depth (meters) 
 Density (kg/m3) 

 
• Second line contains (in order): 

 Total variance of time series (meters2) 
 Total energy of time series (Joules / meters2) 
 Average wave height (meters) 
 Average wave period (seconds) 

 
• Third line contains (in order): 

 Maximum wave height (meters) 
 Significant wave height (meters) [average height of largest  

1/3 waves] 
 Significant period (seconds) [average period of largest 1/3 waves] 
 H1/10 (meters) [average height of largest 1/10 waves] -  

If less than 10 waves, H1/10 is set to 0 
 H1/100 (meters) [average height of largest 1/100 waves] -  

If less than 100 waves, H1/100 is set to 0 
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Surface Wave Time Series (.wt extension)  
 

A .wt file is created from the .wb file in Process Wave Burst Data, if Output 
surface wave time series to .wt file is selected. Part of a sample surface wave 
time series file is shown below: 
 
SBE 26 SEAGAUGE  
*  0   39714178    1.00  32 
 -0.1783     -0.2180     -0.1793     -0.0721 
 0.0615       0.1677      0.2036      0.1582 
 0.0521      -0.0754     -0.1829     -0.2384 
 
• First line - * flags the beginning of the data for a wave burst. Line 

contains (in order): 
 Wave burst number 
 Start of wave measurement (seconds since January 1, 1989) 
 Wave integration period (seconds) 
 Number of points in wave burst 

 
• Second and following lines (until the next line with *) -  

Measured wave amplitudes in meters, with four values per line. 
 
 

Wave Burst Statistics Report (.r26 extension)  
 

A .r26 file is created from the .was and .wts file in Create Reports. Part of a 
sample report file is shown below: 
 

# filename = D:\SBE26\951002[.WAS, .WTS] 
# wave integration time = 1.00 
# number of points in the burst = 1024 
# height of SBE 26 above the bottom = 0.300 
# density = 1024.153 
         Burst    Time-jdays    Time-hours         Depth        Nwaves     Avgheight        Avgper     
Maxheight         H1/10        H1/100       Swp-wts       Swh-wts 
             0     232.67205         0.000        17.759           211  4.600717e-01  3.838863e+00  
3.384997e+00  1.441726e+00  3.134322e+00  4.200000e+00  8.141103e-01 
             1     232.75538         2.000        17.679           185  2.278769e-01  4.383784e+00  
8.741022e-01  7.083250e-01  8.741022e-01  6.344262e+00  5.092874e-01 

 
• Beginning lines - # flags header. Header lines contain (in order): 

 Input file name 
 Wave integration period (seconds) 
 Number of points in the wave burst 
 Height of pressure sensor above bottom 
 Water density 

 
• Column heading line and data –  

Data varies, depending on user-selected variables to be output. 
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Appendix IV: Electronics 
Disassembly/Reassembly 

 
Sea-Bird provides a jackscrew kit with the SBE 26, to assist in removal of the 
connector end cap. The kit contains: 
• 2 Allen wrenches 
• 3 jackscrews 
• 2 spare plastic socket hex-head screws 
 
 
 
 
 

Disassembly 
 

1. Establish communications with the SBE 26 (see Section 5: SBE 26 Setup, 
Installation, and Data Upload - SeatermW for details). As a precaution, 
click Upload to upload any data in memory before beginning. 

 
2. Wipe the outside of the end cap and housing dry, being careful to remove 

any water at the seam between them. 
 
3. Remove the four titanium hex-head screws securing the connector end cap 

to the housing. 
 

4. Remove the three plastic hex-head screws from the end cap using the 
larger Allen wrench. Insert the three jackscrews in these three holes in the 
end cap. When you begin to feel resistance, use the smaller Allen wrench 
to continue turning the screws. Turn each screw 1/2 turn at a time. As you 
turn the jackscrews, the end cap will push away from the housing. When 
the end cap is loosened, pull it and the PCB assembly out of the housing. 

 
5. Remove any water from the O-ring mating surfaces inside the housing 

with a lint-free cloth or tissue. Be careful to protect the O-rings from 
damage or contamination. 

 
6. Disconnect the Molex connector connecting the PCB assembly to  

the battery compartment bulkhead. 
 

7. Remove the jackscrews from the end cap. 
 
 

CAUTION: 
Disconnect and dismount the optional 
SBE 4M conductivity cell from the 
SBE 26 before disassembly to avoid 
breaking the conductivity cell. 

 

 

 

 

Titanium hex-head screw 
(typical, 4 places) 

Plastic hex-head screw 
(typical, 3 places) 

Note: 
Disassembling the electronics 
erases the SBE 26 memory – all 
logged data in memory is lost and all 
user-programmable parameters (date 
and time, sampling scheme, etc.) are 
reset to default values. 

Jackscrew 
kit 
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Reassembly 
1. Remove any water from the O-ring and mating surfaces with a lint-free 

cloth or tissue. Inspect the O-ring and mating surfaces for dirt, nicks, and 
cuts. Clean or replace as necessary. Apply a light coat of O-ring lubricant 
(Parker Super O Lube) to O-ring and mating surfaces. 

 
2. Reconnect the Molex connector to the PCB assembly. Verify the 

connector holds and pins are properly aligned. 
 

3. Carefully fit the PCB assembly into the housing, aligning the holes in the 
end cap and housing. 

 
4. Reinstall the 4 hex-head screws to secure the end cap to the housing. 

 
5. Reinstall the 3 plastic hex head screws in the end cap. 
 
6. Establish communications with the SBE 26 (see Section 5: SBE 26 Setup, 

Installation, and Data Upload - SeatermW for details). Initialize RAM 
(IR), reset the date and time (ST), and re-enter all the setup parameters. 

 
 
 

Note: 
Before delivery, a desiccant package 
is inserted in the housing and the 
electronics chamber is filled with dry 
Argon gas. These measures help 
prevent condensation. To ensure 
proper functioning: 
1. Install a new desiccant bag each 

time you open the electronics 
chamber. If a new bag is not 
available, see Application  
Note 71: Desiccant Use and 
Regeneration (drying). 

2. If possible, dry gas backfill each 
time you open the housing. If you 
cannot, wait at least 24 hours 
before redeploying, to allow the 
desiccant to remove any moisture 
from the housing. 

Note that opening the battery 
compartment does not affect 
desiccation of the electronics. 
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Appendix V: AF24173 Anti-Foulant Device 
 
 
AF24173 Anti-Foulant Devices supplied for user replacement are supplied in 
polyethylene bags displaying the following label: 
 

AF24173 ANTI-FOULANT DEVICE 
 
FOR USE ONLY IN SEA-BIRD ELECTRONICS' CONDUCTIVITY SENSORS TO CONTROL THE GROWTH OF AQUATIC ORGANISMS 
WITHIN ELECTRONIC CONDUCTIVITY SENSORS. 
 
ACTIVE INGREDIENT: 
Bis(tributyltin) oxide…………..………………………….....  53.0% 
OTHER INGREDIENTS:  ……………………………….....  47.0% 
Total……………………………………………………….....  100.0% 
 
DANGER 
See the complete label within the Conductivity Instrument Manual for Additional Precautionary Statements and Information on the Handling, Storage, and 
Disposal of this Product. 
 
Net Contents:  Two anti-foulant devices 
Sea-Bird Electronics, Inc. EPA Registration No.  74489-1 
13431 NE 20th Street EPA Establishment No. 74489-WA-1 
Bellevue, WA  98005 
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AF24173 Anti-Foulant Device 
 
FOR USE ONLY IN SEA-BIRD ELECTRONICS’ CONDUCTIVITY SENSORS TO CONTROL 
THE GROWTH OF AQUATIC ORGANISMS WITHIN ELECTRONIC CONDUCTIVITY 
SENSORS. 
 
 
ACTIVE INGREDIENT: 
Bis(tributyltin) oxide…………..…………………………..... 53.0% 
OTHER INGREDIENTS:  ………………………………..... 47.0% 
Total……………………………………………………….....  100.0% 
 
 
DANGER 
See Precautionary Statements for additional information. 
 
 

FIRST AID 
If on skin or 
clothing 

• Take off contaminated clothing. 
• Rinse skin immediately with plenty of water for15-20 minutes. 
• Call a poison control center or doctor for treatment advice. 

If swallowed • Call poison control center or doctor immediately for treatment advice. 
• Have person drink several glasses of water. 
• Do not induce vomiting.  
• Do not give anything by mouth to an unconscious person. 

If in eyes • Hold eye open and rinse slowly and gently with water for 15-20 
minutes. 

• Remove contact lenses, if present, after the first 5 minutes, then continue 
rinsing eye. 

• Call a poison control center or doctor for treatment advice. 
HOT LINE NUMBER 
Note to Physician Probable mucosal damage may contraindicate the use of gastric lavage. 
Have the product container or label with you when calling a poison control center or doctor, or 
going for treatment. For further information call National Pesticide Telecommunications 
Network (NPTN) at 1-800-858-7378. 
 
 
Net Contents:  Two anti-foulant devices 
 
 
 
Sea-Bird Electronics, Inc.     EPA Registration No.  74489-1 
13431 NE 20th Street    EPA Establishment No. 74489-WA-1 
Bellevue, WA 98005 
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PRECAUTIONARY STATEMENTS 
 

HAZARD TO HUMANS AND DOMESTIC ANIMALS 
 

DANGER 
 

Corrosive - Causes irreversible eye damage and skin burns.  Harmful if swallowed. Harmful if 
absorbed through the skin or inhaled.  Prolonged or frequently repeated contact may cause allergic 
reactions in some individuals. Wash thoroughly with soap and water after handling.  
 

PERSONAL PROTECTIVE EQUIPMENT 
 

USER SAFETY RECOMMENDATIONS 
Users should: 
• Remove clothing immediately if pesticide gets inside.  Then wash thoroughly and put on 

clean clothing. 
• Wear protective gloves (rubber or latex), goggles or other eye protection, and clothing to 

minimize contact.  
• Follow manufacturer’s instructions for cleaning and maintaining PPE.  If no such instructions 

for washables, use detergent and hot water.  Keep and wash PPE separately from other 
laundry. 
• Wash hands with soap and water before eating, drinking, chewing gum, using tobacco or 

using the toilet. 
        
 

 
ENVIRONMENTAL HAZARDS 

 
Do not discharge effluent containing this product into lakes, streams, ponds, estuaries, oceans, or other 
waters unless in accordance with the requirements of a National Pollutant Discharge Elimination 
System (NPDES) permit and the permitting authority has been notified in writing prior to discharge. 
Do not discharge effluent containing this product to sewer systems without previously notifying the 
local sewage treatment plant authority. For guidance contact your State Water Board or Regional 
Office of EPA. This material is toxic to fish. Do not contaminate water when cleaning equipment or 
disposing of equipment washwaters. 
 
PHYSICAL OR CHEMICAL HAZARDS 
Do not use or store near heat or open flame. Avoid contact with acids and oxidizers. 
 
DIRECTIONS FOR USE  
It is a violation of Federal Law to use this product in a manner inconsistent with its labeling. For use 
only in Sea-Bird Electronics’ conductivity sensors. Read installation instructions in the applicable 
Conductivity Instrument Manual.  



Manual revision 017 Appendix V: AF24173 Anti-Foulant Devices SBE 26 

 84 

 
STORAGE AND DISPOSAL 

 
PESTICIDE STORAGE:  Store in original container in a cool, dry place. Prevent exposure to 
heat or flame. Do not store near acids or oxidizers. Keep container tightly closed. 
  
PESTICIDE SPILL PROCEDURE:  In case of a spill, absorb spills with absorbent material. Put 
saturated absorbent material to a labeled container for treatment or disposal. 
 
PESTICIDE DISPOSAL:  Pesticide that cannot be used according to label instructions must be 
disposed of according to Federal or approved State procedures under Subtitle C of the Resource 
Conservation and Recovery Act. 
 
CONTAINER DISPOSAL:  Nonrefillable container. Do not reuse this container for any purpose. 
Offer for recycling, if available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Sea-Bird Electronics/label revised 01-28-10 
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Appendix VI: Wave Theory and Statistics  
 

Surface Gravity Waves - Description 
 

Types of Waves and Restoring Forces 
 
The most characteristic physical feature of any kind of wave is the restoring 
force. If a medium at rest (such as still water) is disturbed in some way (by the 
wind, for example, or by dropping a rock into a pond), the restoring force acts 
to return the medium to its initial still state. 
 
Compressibility is the restoring force for sound waves. Surface tension acts as 
the restoring force at any surface of contact between any two different fluids 
(like air and water), and produces very high frequency capillary waves. 
Gravity waves arise through the restoring force of gravity on water particles 
displaced from equilibrium levels. If the equilibrium level is a free surface (the 
boundary between water and air), surface gravity waves are formed. If the 
equilibrium level is an internal surface in a stratified fluid, internal gravity 
waves are formed. These internal waves tend to have longer periods (minutes 
to hours) than surface gravity waves (seconds). Finally, planetary effects such 
as rotation introduce restoring effects such as the Coriolis force and potential 
vorticity, yielding very long period waves called inertial waves, Rossby, and 
planetary waves. 
 
 
Spectrum of Surface Waves in the Ocean 
 
Surface waves in the ocean occupy a broad range of wavelengths and periods. 
• At extremely short periods, the spectrum is dominated by capillary waves, 

followed by a broad (1 - 20 second) band of surface gravity waves, mostly 
wind driven. 

• Longer period (> 10 minutes) gravity waves may occur in association with 
earthquakes and large-scale meteorological systems (storm surges). 

• Tides, which are another type of forced gravity wave, dominate the 
spectrum in the 12 - 36 hour band. 

• At longer periods, inertial and planetary waves are prevalent; gravity does 
not play a dominant role any longer. 

 
See Pond and Picard (Figure 12.1, Table 12.1) (Appendix VIII: References). 
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Definition of Terms 
 
a = wave amplitude, [m] 
 

Dw = density of water, [Kg/m3] 
 

E = Ww H2 / 8, total wave energy per unit area, [J/m2] 
 

f = 1 / T, wave frequency, [Hz], [cycles/sec] 
 

g = 9.80665, acceleration of gravity, [m/sec2] 
 

h = water depth, [m] 
 

H = 2a, wave height, [m] 
 

k = 2 π / L, wave number, [rad/m] 
 

L = wave length, [m] 
 

φ = phase angle, [radians] 
 

σ = 2 π / T, radian frequency, [rad/sec] 
 

t = time, [sec] 
 

T = wave period, [sec] 
 

Tb = total time of the wave burst series (total sample period), [sec] 
 

Ww = Dw g, specific weight of water, [Kg/(m2sec2] = [Pa/m] 
 

x = horizontal distance, [m] 
 

z = instrument depth, [m] 
 
 
Basic Linear Wave Description 
 
A traveling disturbance of the sea surface is commonly represented as a linear 
simple harmonic wave traveling in the x horizontal direction: 
 
 A (x,t) = a cos (kx - σt + φ) [1] 
 
 
 
 
 
 

 

Trough 

Crest 

Mean water level 

L 

H 

h 

Seafloor 

Simple-Harmonic Linear Wave Traveling on the Sea Surface 
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Phase Angle 
 
The phase angle φ represents a shift of the wave relative to some reference 
time. This is useful for describing the relationships between a group of waves 
of different frequencies. When a time series is separated by spectral analysis 
methods into frequency components defined by [1], the two numbers that are 
computed for each frequency are: 
 
 amplitude a(f) 
 
 phase  φ(f) 
 
The physical time lag associated with a given phase depends on the wave 
period (T). For example, a phase of π radians implies a time lag of 5 seconds 
for a wave with a period of 10 seconds (T = 10 sec), while the same phase 
implies a lag of 2.5 sec for a wave with T = 5 sec. 
 
 
Dispersion Equation 
 
For surface gravity waves described by [1], there is a special relationship 
between wave period and wave length. This relationship, which depends on 
water depth, is called the dispersion relation and is given by: 
 
 σ 2 = gk tanh (kh) [2] 
 
 
Implications of Linear Theory 
 
Equation [1] represents a single frequency-wavenumber component of a sea 
surface that usually contains a whole group of waves of different sizes, 
lengths, and propagation directions. One of the major assumptions of linear 
theory is that we can take this jumbled combination and treat each frequency 
component (or frequency band) separately by using [1]. 
 
First order linear small amplitude theory is the simplest and most direct 
solution to a very complex general set of equations and boundary conditions 
for surface gravity waves. The simple results are based on a set of 
approximations that are strictly valid only over a restricted range of conditions. 
Small amplitude wave theory is not a good model of steep or breaking waves, 
or waves traveling in very shallow water. The theory is a good model of long 
ocean waves away from viscous boundary layers and horizontal boundaries. 
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Assumptions 
 
For the linear theory to be valid, a major requirement is that the wave height H 
be small compared with both the wavelength L and the water depth h. These 
conditions are usually expressed as: 
 
 H / L << 1  (wave steepness) 
 
 H L2 / h3 << 1  (Ursell parameter) 
 
Another measure of the effect of wave steepness on the validity of the small 
amplitude theory, based on laboratory measurements, is shown below. For the 
theory to be valid, you must be below the curve indicated. For example, if the 
wave period of interest T is 10 sec and the water depth h is 100 meters, the 
parameter h / gT2 = 0.1. This means that H / gT2 must be less than 0.001 for 
the theory to be valid, which translates into a maximum wave height of  
1 meter. 

 
 
 

A final rule of thumb is that estimates of surface wave heights should be 
accurate within ± 5% provided: 
 
 z / L < 0.3 to 0.5, 
 
where z is the depth of the instrument below the surface and L is the 
wavelength of the observed waves. 

h / gT2 

H / gT2 

Range of Validity of Linear Wave Theory 
(Theory Valid for Values Below Curve) 
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Subsurface Pressure Due to Surface Gravity Waves 
 
As a surface wave passes over a subsurface position, the elevation and 
depression of the sea surface causes a differential subsurface pressure 
disturbance. This pressure disturbance decays with depth according to  
the relation: 
 
 p = WW A (t) K (f,z)       [Pa] [3] 
 
where the vertical pressure response function is: 
 
 K (f,z) = cosh [k (h - z)] / cosh (kh)        [dimensionless] [4] 
 
where 
A(t) (defined by [1]) = water surface displacement, which varies between +a 
and -a meters 
Ww = specific weight of water near the surface 
h = water depth 
k = wave number [radians/m], calculated for a given wave period and depth 
with the dispersion relation [2] 
z = vertical distance [m] from the measurement point to the mean 
(undisturbed) water surface 
 
 
Equation [3] is the essential result required to relate subsurface pressure to 
surface wave height. For a given pressure frequency component P(f), the 
transfer function used to obtain surface wave amplitude a(f) from subsurface 
pressure is: 
 
 a (f) = P (f) / WW K (f,z)        [m] [5] 
 
 
For deep water waves (kh >> 1 and h/L > 0.5) equation [3] takes the form: 
 
 p ≈ WW A e -kz        [Pa] [6] 
 
which clearly represents an exponential decay with depth. 
 
 
For shallow water waves (hk << 1 and h > L/2) equation [3] takes the form: 
 
 p ≈  WW A       [Pa] [7] 
 
which is simply the hydrostatic equation. 
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The table below, developed with Plan Deployment, shows pressure attenuation 
[p(bottom) / p(surface)] vs. bottom depth for waves with T = 2, 5, 10, 20, and 
25 seconds. 
 

Water 
Depth 

[meters] 

Sensor Height 
above Bottom 

[meters] 

Wave Period [seconds] 

25 20 10 5 2 

2 0 0.99 0.99 0.96 0.84 0.25 

4 0 0.99 0.98 0.92 0.70 0.04 

8 0 0.97 0.96 0.84 0.45 ----- 

15 0 0.95 0.93 0.72 0.17 ----- 

20 0 0.94 0.90 0.63 0.08 ----- 

30 0 0.91 0.85 0.48 0.02 ----- 

40 0 0.87 0.81 0.35 ----- ----- 

50 0 0.84 0.76 0.25 ----- ----- 

75 0 0.77 0.65 0.1 ----- ----- 

100 0 0.70 0.55 0.04 ----- ----- 
Pressure attenuation [p(bottom) / p(surface)] for various bottom depths  

and wave periods (----- = less than 0.001). 
 
 
 
High Frequency Cutoff 
 
The table above shows that the pressure attenuation with depth is a strong 
function of the wave period; short period waves attenuate much faster with 
depth than longer period waves. This implies that for a pressure sensor 
deployed at a fixed depth z, there is a high frequency cutoff fmax for which 
waves with f > fmax are not measurable. Above the high frequency cutoff, any 
noise in the subsurface pressure record is mapped by the transfer function into 
unrealistic surface wave height values. The default high frequency cutoff for 
Process Wave Burst Data is the frequency where the ratio of pressure 
measured by the SBE 26 to pressure at the surface is less than  
(0.0025 / wave sample interval) [see equation 20]. Frequencies greater than 
fmax are not processed by Process Wave Burst Data for most applications. 
 

 

Example: 
Water depth is 10 meters. You are interested in measuring waves with 
frequencies up to 0.36 Hz (period = 1 / 0.36 = 2.8 seconds). You plan to 
sample waves 4 times per second (wave sample interval = 0.25 seconds) 
with 1024 samples per wave burst, and to process data with 10 spectral 
estimates/band. Can you place the SBE 26 at 1 meter above the bottom and 
accomplish your goals? 
 
Running Plan Deployment with the above parameters, the Frequency Span is 
0.0215 to 0.3340 Hz. Since 0.334 < 0.37, you cannot accomplish your goals. 
 
Iterating on a solution by changing the instrument height in Plan Deployment, 
you find that placing the SBE 26 at 2.5 meters above bottom will allow you to 
measure the desired frequencies. Alternatively, you could consider modifying 
other sampling parameters while maintaining the instrument height. 

Note: 
Frequencies greater than fmax 
are processed if Use filter  
cutoff is selected in Process  
Wave Burst Data. 
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Wave Processing Steps 
 
To compute surface wave energy spectra and statistics, the frequency 
dependent attenuation must first be removed from the subsurface pressure 
data. Fourier analysis techniques are used to decompose the subsurface time 
series into a group of linear wave components, each with a distinct frequency, 
amplitude, and phase. 
 
 
Initial Processing of Pressure Data 
 
First the wave burst data is read into an array. The mean is computed and then 
the mean and trend are removed from the array. A trend is expected in the 
wave data due to tides and other low frequency waves. If these trends are  
not removed, distortions can occur in the processing of spectral estimates;  
the ramp function in the time domain leaks all over the spectrum in the 
frequency domain. 
 
Density (Dw ) is computed from the user-supplied salinity and temperature. 
 
Instrument depth (z) and water depth (h) are computed by: 
 
 z = 6894.757 ( mean pressure - 14.7 ) / DW g     [m] [8] 
 
 h = z + height of pressure sensor above bottom     [m] [9] 
 
where the factor 6894.757 is used to convert the pressure from psi to Pascals. 
 
 
If the number of wave samples is not a power of two, the array length is  
made a power of two by filling it with the last de-meaned and de-trended 
pressure value. 
 
Next, a Hanning window is applied to the time series to suppress the spectral 
leakage that occurs when the time series to be Fourier transformed contains a 
periodic signal that does not correspond to one of the exact frequencies of the 
FFT. Physically, this means that an integral number of waves does not fit in 
the time series. When this occurs, energy at one frequency leaks to other 
frequencies. This causes errors when applying the frequency dependent 
dispersion transfer function to the transformed data. The Hanning window has 
the form: 
 
 u (t) = 1 - cos2 (π t / Tb )     0 < t < Tb [10] 
 
 
The windowing operation reduces the total energy in the time series so each 
element is multiplied by the scale factor SF, where 
 
 SF =   (8 / 3 ) 1/2 [11] 
 
to obtain the correct magnitudes in later spectral estimates. 
 
 
Finally, each element in the time series is multiplied by the factor 6894.757 to 
convert the measured pressure from psi to Pascals. 
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Surface Wave Auto-Spectrum 
 
The Finite Fourier transform of a time series with N points contains N raw 
spectral estimates at frequencies given by: 
 
 Fj = j | Tb     j = 0, N-1     [Hz] [12] 
 
where Tb is the total time of the series (seconds). The first spectral estimate  
(j = 0) is the mean of the time series, and is 0 since the subsurface pressure 
time series has been de-meaned. 
 
 
The interval between spectral estimates (resolution bandwidth) is: 
 
 δf = 1 / Tb = 1 / (Nδt) [13] 
 
where δt is the time interval between samples in the subsurface pressure  
time series. 
 
While N raw spectral estimates are computed, only the first (N/2 + 1) are 
unique. For a real input time series the second (N/2 - 1) values are identical to 
the first N/2 values. The limiting frequency is the Nyquist frequency, given by: 
 
 Nyquist = 1 / (2δt)     [Hz] [14] 
 
 
The forward Fourier transform of the time series is defined by: 
 
 Zj =  (1 / N)           xn exp (-i 2 π n j / N) [15] 
 
where  
Zj (the raw spectral estimates) are complex numbers. 
i = ( -1 ) 1/2 
 
 
The raw spectral estimates are directly related to the single frequency wave 
described in [1]: 
 
 aj =  2 | Z j |  ,          φ j = arg (Z j ) [16] 
 
 
The variance at each frequency is: 
 
 varj =  | Z j | 2  ,          j = 1, N-1 [17] 
 
 
The total variance of the spectrum: 
 
 
 var total =           | Z j | 2      [Pa2] [18] 
 
 
is equal to the variance calculated from the time series [28]. 
 
 
For each frequency up to the Nyquist, the relationship between the single 
pressure wave variance [1] and [17] is: 
 
 aj 2 / 2 = 2 var j [19] 
 

N - 1 

∑ 
n = 0 

N - 1 

∑ 
j=1 
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Once the Fourier transform has been obtained, the Fourier coefficients for the 
frequencies greater than fmax and less than fmin are typically set to 0.0: 
 
 fmax = minimum of: 
 frequency where ( subsurface / surface pressure = 0.0025 / δ t ) [20] 
 or 
 1 / user input minimum period [21] 
 
 fmin = 1 / user input maximum period [22] 
 
Maximum frequency limits prevent noise in the subsurface time series from 
being mapped by the dispersion transfer function into unrealistic wave heights. 
 
If the user selected Use filter cutoff, a filter is applied that ramps the Fourier 
coefficients down to 0 for frequencies greater than fmax and less than fmin. 
• For frequencies less than fmin:  

fourier coefficient = f * exp ([f – fmin]/ fc) 
• For frequencies greater than fmax:  

fourier coefficient = f * exp ([fmax – f]/ fc) 
where 
f = frequency 
fc = user input filter value 
 
A copy of the Fourier transform is saved; it will be used to recover the surface 
wave time series. 
 
 
Band Averaging 
 
Each raw spectral estimate contains two degrees of freedom. Band averaging 
can be used to increase the number of degrees of freedom and reduce the error 
of the estimate. The number of degrees of freedom (n d) associated with 
grouping n f spectral estimates in a frequency band of width δf is twice the 
number of frequencies in the band. δf = n f / T b 
 
Band averaging is performed by adding up the total variance in a frequency 
band and dividing the sum by the width (Hz) of the frequency band (δf). For 
positive frequencies less than the Nyquist, the estimate of the one-sided 
subsurface pressure auto-spectral density function for a frequency band 
centered at fb is: 
 
 
 
 < G pp (f b ) > =                                                     [Pa2 sec] [23] 
 
 
 
 
Confidence Intervals (Error Bars) 
 
The properties of a real-world (random) time series cannot be precisely 
determined from sample data. Only estimates of the parameters of interest can 
be obtained. The method for setting error bars on the estimates of the auto-
spectral density function <Gpp> is related to the Chi-Square distribution 

function:X2. 
 

      n f 

2   ∑    | Z k | 2 
     k=1 
      

          δf 
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The confidence interval (1-α; α is the significance) for the true auto-spectral 
value Gpp based on an estimate <Gpp> is given by: 
 
 
                           < G pp (f b ) <  [24] 
 
 
 
where 
 
 nd = 2 * number of frequency bands averaged 
 

X2nd;α = percentage points, Chi-Square distribution with nd degrees of 
freedom and significance α 

 
The Chi-Square distribution is described completely in most statistics books  
(for example, J. E. Freund, Mathematical Statistics, 1962, Prentice Hall, Inc.). 
For example, if 10 frequencies are averaged per band and we wish to know the 
error bars corresponding to the 90% confidence interval: 
 
 nd = 20   alpha = significance = 0.1 
 
 X2

20;0.05 = 31.41  X2
20;0.95 = 10.85 

 
Therefore, the error bar is: 
 
 (0.637 <G pp>) ≤ G pp ≤ (1.843 <G pp>) 
 
This means that we can say with 90% certainty that the true value of Gpp lies 
somewhere between 0.637 and 1.843 times the estimated value of Gpp. 
 
When band averaging, the value of the auto-spectral estimate lies somewhere 
in the band averaged frequency band; the error bars for the frequency are as 
wide as the band. 
 
Band averaging is a trade-off between vertical and horizontal error bars. If you 
average a lot of bands, you get a good estimate of the magnitude of a peak in 
Gpp, but there is a lot of uncertainty as to its precise frequency value. If you 
band-average only a few bands, the frequency of a peak is precisely defined, 
but there is a lot of uncertainty as to the value of Gpp. 
 
Sometimes a peak in the spectrum stands out from the background if there are 
few frequencies in the band, but vanishes into the background as the number 
of frequencies averaged increases. When this happens, an understanding of the 
physical problem being investigated can help in deciding whether the peak is 
real or not. 
 
 
Surface Wave Auto-Spectral Density Function 
 
The one-sided surface wave auto-spectral density function for a frequency 
band centered at fb is: 
 
 Gaa ( f b ) = | H (f b ) |2 Gpp ( f b )      [m2 sec] [25] 
 
The transfer function H (fb) is used to convert the subsurface pressure to 
surface waves and is computed with equations [2] and [4]. 
 
 H ( f b ) = 1 / [ Ww K ( f, z ) ]     [m / Pa] [26] 

n d <G pp> 
      

X2 n d; 1 - α / 2 

n d <G pp> 
      

X2 n d; α / 2 
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A plot of the surface wave auto-spectral density function Gaa with error bars is 
probably the most useful way of describing the sea surface shape due to a 
surface wave field. A glance at the spectrum shows where the wave variance is 
in frequency space. 
 
The surface wave spectral density function Gaa has units of [m2 sec]. To find 

the variance [m2] in a frequency interval δf (Hz), multiply Gaa by δf. 
 
 
Total Variance and Energy 
 
The total variance Vartot is the sum of all the band-averaged spectral estimates: 
 
 
 
 var tot =           G aa (f k) δf        [m2] [27] 
 
 
where 
δf is the number of spectral estimates in the band divided by the total sample 
period, 
nb is the number of frequency bands computed,  
Gaa(fk) is the spectral estimate for the frequency centered at fk. 
 
The total wave energy (J / m2) is found by multiplying the total variance by 
the specific weight of water (Ww). 
 
 
Significant Wave Height and Period 
 
The significant wave height is the average height of the highest 1/3 of the 
waves and is estimated from the auto-spectrum as: 
 
 
 H 1/3 =    4  ( Var tot ) 1/2      [m] [28] 
 
 
The significant wave period estimated from the auto-spectrum is the period 
corresponding to the frequency with the highest variance. 
 
 
Surface Wave Time Series 
 
To reconstruct the surface wave time series from the subsurface pressure, the 
transfer function H(fi) [see equation 26] is applied frequency by frequency to 
the scaled raw spectral estimates: 
 
 A ( f i ) = H ( f i ) P ( f i )         f i < Nyquist [29] 
 
 
where A(fi) are the raw spectral estimates of surface wave amplitude and P(fi) 
are the spectral estimates of subsurface pressure. The spectral estimates for  
fi > Nyquist are given by A(Fn-i) = A(fi). 
 
The Inverse Fast Fourier Transform (IFFT) is taken to construct the surface 
time series. 
 

 nb 

∑ 
k=1 
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The influence of the Hanning window is removed with a deconvolution in the 
time domain; each point xi is multiplied by the inverse of the Hanning window 
wi corresponding to the same time point. This procedure is unstable near the 
end points where wi ≈ 0. Therefore, the time series is set to 0 at the beginning 
and end where the window reaches 1% of its maximum value. 
 
Finally, each point in the time series is multiplied by 1 / sqrt (8/3) to 
compensate for the initial scaling of the time series. 
 
 
Total Variance and Energy 
 
The unbiased sample variance is a fundamental statistical measure of the time 
series. Variances from different bursts can be compared to see if the wave field 
is stationary or changing. The unbiased estimator for the variance is: 
 
 
 < σx 2> =  (1 / [N-1])        | x j  - < μ x> | 2        [m2] [30] 
 
 
where μx is the sample mean. In this case, the mean is zero since the time 
series has been de-meaned. The variance obtained from the reconstructed time 
series can be compared with the total variance obtained from the auto-
spectrum [25] as a check on the goodness of the time series reconstruction. 
 
An estimate of the total wave energy contained in the record is: 
 
 E = W w < σx 2>         [J / m2] [31] 
 
 
Average Wave Height and Period: Havg, Tavg 
 
Since the wave time series is typically very irregular due to the random nature 
of the sea surface, the calculation of wave heights and periods can only be 
approximate and statistical. A standard method for estimating wave heights 
and wave periods is summarized in the Handbook on Wave Analysis and 
Forecasting, from the World Meteorological Organization (WMO- No. 446, 
1976, Geneva, Switzerland) and illustrated below: 
 

 

Individual waves are isolated by identifying the zero upcrossings; H and T for 
each captured wave is stored in an array. Averaging over all the captured 
waves yields the average wave height Havg (meters) and the average period  
Tavg (seconds). Hmax is the largest captured wave. 
 

N-1 

∑ 
j=0 

Zero-Crossing Method for Estimating Wave Heights and Periods 
from a Wave Time Series 
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Sea State (Significant Wave Height) 
 
The significant wave height (H1/3) and average period (Tavg) define the sea 
state. H1/3 is the average height of the highest 1/3 of the waves and has 
physical significance because it is the approximate wave height picked out 
visually and reported by trained observers at sea. 
 
T1/3 is obtained by picking out the highest 1/3 of the captured waves and 
averaging their periods. 
 
The parameters H1/10 and H1/100 are similarly defined as the average height of 
the highest 10 and 1 percent of the captured waves, respectively. 
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Appendix VII:  
Pressure-to-Depth Conversion 

 
Force is mass * acceleration, units are Newtons [N]: 
 
 N = Kg m / sec 2 
 
 
Density (ρ) is mass / volume, units are [Kg/m 3]: 
 

This is the in situ value, and is approximately 1025 Kg/m 3  
at the surface. 

 
 
Specific weight (W) is weight / volume, units are [N/m 3]: 
 
 W = ρ * g 
 
 where g = local gravity [m / sec 2] 
 
 
Hydrostatic equation: 
 
 p = patm + W * z 
 
 patm = atmospheric pressure in Pascals  [N / m 2] 
 
 p = total pressure in Pascals  [N / m 2] 
 
 W is average density times gravity [N/m 3] 
 
 z = depth [m] 
 
 
Conversions: 
 
 1 Pascal = 10-4 decibars 
 
 1 psi = 0.6894757 decibars 
 
 
Example: 
 
 average density = 1025 kg / m 3 
 
 average gravity = 9.8 m / sec 2 
 
 pressure reading = 6000 decibars = 6 x 10 7 Pascals 
 
 atmospheric pressure = 14.7 psia = 1.013529 x 10 5 Pascals 
 
 W = 1025 * 9.8 = 10045   [N / m 3] 
 
 6 x 10 7 - 1.013529 x 10 5= 10045 * z 
 
 z = 5.989865 x 10 7 / 10045 = 5963.031 meters 
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Appendix IX: Replacement Parts 
 

Part 
Number Part Application Description Quantity 

in 26 

22018 
Battery, alkaline  
D-cell, Duracell 
MN1300 (LR20) 

Power SBE 26 9 

41124 Battery cover plate Retains alkaline batteries 1 

801483 
9D (10.8 V/42 amp-
hours) lithium battery 
pack kit 

Note: Batteries not included. - 

30346 Screw, 10-24 x 1”  
hex-head, titanium 

Secures connector end cap to 
optional titanium housing 4 

50092 SBE 16/19  
Jackscrew Kit For removing connector end cap 1 

60021 Spare battery end  
cap parts 

Assorted o-rings and hardware: 
• 30090, Parker, 2-153N674-70 

(housing face seal) 
• 30145, Mach Screw, 6-32 x ½ PH 

SS (secures battery retainer plate to 
bulkhead posts) 

• 30242, Washer, #6 Flat, SS (for 
30145 screws) 

• 30816, Parker, 2-234E603-70 
(battery end cap piston seal) 

- 

50056 Spare parts kit 

Assorted spare parts: 
• 30090, Parker, 2-153N674-70 (face 

seal, battery end cap) 
• 30815, Parker, 2-233E603-70 

(piston seal, connector end cap) 
• 30816, Parker, 2-234E603-70 

(piston seal, battery end cap) 
• 30145, Mach screw, 6-32 x ½ PH 

SS (battery endplate) 
• 30242, Washer, #6, Flat SS (for 

30145 screws) 
• 30447, Bolt, ¼-20 x 1-1/4 Hex 

(end cap lift eye hardware) 
• 30493, Mach screw, 10-24 x 1-1/4 

(secures connector end cap to 
plastic housing) 

• 30552, Retaining ring (secures 
mounting fixture to its bolt) 

1 

Continued on next page 
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Continued from previous page 
Part 

Number Part Application Description Quantity 
in 26 

17695 

3-pin to 3-pin cable, 
RMG-3FS to  
RMG-3FS,  
0.28 m (11 in.) long 

From SBE 26 to optional 
conductivity sensor -  standard 
connectors 

1 

171752 

3-pin to 3-pin cable, 
MCIL-3FS to  
RMG-3FS,  
0.28 m (11 in.) long 

From SBE 26 to optional 
conductivity sensor - optional 
wet-pluggable connector on  
SBE 26 

1 

801225 

4-pin RMG-4FS  
to DB-9S  
data I/O cable,  
2.4 m (8 ft) long  

From SBE 26 to computer -  
standard connector 1 

801374 

4-pin MCIL-4FS  
to DB-9S  
data I/O cable,  
2.4 m (8 ft) long 

From SBE 26 to computer - 
optional wet-pluggable connector 1 

171888 
25-pin DB-25S to  
9-pin DB-9P cable 
adapter 

For use with computer with  
DB-25 connector 1 

17043 Locking sleeve Locks I/O cable or dummy plug 
in place - standard connector 2 

171192 Locking sleeve 
Locks I/O cable or dummy plug 
in place - optional wet-pluggable 
connector 

2 

17045.1 
3-pin RMG-3FS 
dummy plug with 
locking sleeve 

For when optional conductivity 
sensor not used - standard 
connector 

1 

171500.1 
3-pin MCDC-3-F 
dummy plug with 
locking sleeve 

For when optional conductivity 
sensor not used - optional wet-
pluggable connector on SBE 26 

1 

17046.1 
4-pin RMG-4FS 
dummy plug with 
locking sleeve 

For I/O connector during 
deployment – standard connector 1 

171398.1 
4-pin MCDC-4-F 
dummy plug with 
locking sleeve 

For I/O connector during 
deployment - optional wet-
pluggable connector 

1 

801347 / 
801542 

AF24173  
Anti-Foulant Device 

For use with optional 
conductivity sensor – 
Bis(tributyltin) oxide device 
inserted into anti-foulant  
device cup in mount kit 

1  
(set of 2) 

50315 Anti-foulant device 
mount kit 

Mounts on ends of conductivity 
cell to hold AF24173 Anti-
Foulant Devices 

1 

30411 Triton X-100 

Octyl Phenol Ethoxylate – 
Reagant grade non-ionic cleaning 
solution for conductivity cell 
(supplied in 100% strength; 
dilute as directed) 

1 

50102 Mounting fixture Optional mounting fixture with 
mooring lock pin 1 
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Appendix X: Manual Revision History 
 
Manual 
Version Date Description 

006  • Add conductivity channel, and add cy/cn commands to enable and disable conductivity logging.  
• Update figure to show two-connector end cap. 

008  • Change quiescent current to 1.2ma to reflect new Paroscientific circuit. 
009  • Change installation instructions, refer to setup26.bat. 
010  • Add support for Merge26, add ptoz appendix. 
011  • Change wording of high frequency cut-off 
012 10/94 • Change reference from PIZZAZ PLUS to PIZZAZ 5. 
013 02/06 • Completely rewrote manual, added graphics, etc. 

• Added information on Windows software (SeatermW) which replaces WDisp, Plan26, and Term26. 
014 12/02 • Add information on memory consumption – 3 bytes for wave burst sample, 4 bytes tide sample. 

Replace PN 24012 anti-foul assembly in appendix with PN 50315 assembly.  
• Appendix (data formats) – 47662.5 / 9532.5 in Tide Record equation and example are for 45 psia 

only, and these are now out of date as well. Values vary depending on pressure sensor; values are 
stored in EPROM. Change equation and change example. 

• Change B in DC command example to 4766.3 (new value for 45 psia sensor). 
015 05/03 • Incorporated release of complete Windows version of Seasoft for Waves. 

• Added information on handling of optional lithium batteries. 
• Updated replacement parts list. 

016 06/06 • Housings rated to 600 and 7000 meters, not 680 and 6800 meters 
• Update manual for software changes (Battery and Memory Endurance was added after stopped 

production of the 26). 
• Add diagrams to visually explain sampling parameters. 
• Lithium batteries not available from Sea-Bird, update shipping precautions, remove from 

replacement parts list, add battery pack kit. 
• Add pressure sensor maintenance information. 
• Add Appendix on AF24173 Anti-Foulant Devices 
• Add Recovery information, with warning about pressure in housing. 
• Correct information on PN 22018; 1 battery, not 9. 
• Update Triton website URL. 
• Update conductivity cell cleaning to correspond to revised application note 2D. 

017 09/11 • Update for Seasoft for Waves 2.0 – Update Convert Hex dialog box to reflect changes. 
• Update for previous Seasoft for Waves changes – .ini file for calibration coefficients changed to 

.psa file, location of SeasoftWaves.ini changed (better compatibility with Vista), SeatermW menu 
changes (Connect and Configure menus replaced by Communications menu). 

• Update recommended minimum system requirements for installing software; add information 
about compatibility with Windows 7. 

• Remove all information on DOS software. 
• Correct .wb and .wt file description (said “start of tide measurement’, corrected to “start of wave 

measurement”). 
• Add information on battery storage – replace main batteries every year to prevent leaking. 
• Update information on connector maintenance – was inconsistent with application note 57. 
• Change front cover photo (previously showed orientation in mounting fixture inconsistent with 

SBE 26). 
• Update AF24173 Anti-Foulant Device appendix to current label. 
• Add notes to clarify that Sea-Bird does not provide barometric pressure (.bp) file, must be created 

by customer. 
• Update website information for Triton. 
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B 
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replacing · 57 
Battery and Memory Endurance · 19 
Battery endurance · 19 
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C 
Calibration · 62 
Calibration coefficients · 62 
Command summary · 68 
Commands 

descriptions · 26 
diagnostic · 32 
logging · 31 
setup · 28, 29, 30 
status · 27 
upload · 31 

Communication defaults · 23 
Conductivity cell storage/cleaning · 61 
Connector · 56 
Connectors · 12 
Convert Hex · 36 
Corrosion precautions · 56 
Create Reports · 45 

D 
Data format · 16, 70 

.hex · 70 

.r26 · 78 

.rpt · 76 

.tid · 74 

.was · 75 

.wb · 74 

.wt · 78 

.wts · 77 
converted data · 74 
surface wave time series · 78 
tide data · 74 
uploaded data · 70 
wave auto-spectrum report · 76 
wave auto-spectrum statistics · 75 
wave data · 74 
wave statistics · 78 
wave time series statistics · 77 

Data I/O · 13 
Deployment · 33 
Depth to pressure conversion · 98 
Dimensions · 12 

E 
Electrochem lithium batteries · 7 
Electronics disassembly/reassembly · 79 
End cap · 56 
End cap connectors · 12 
Extensions · 16, 70 

F 
File extensions · 16, 70 
File formats · 16, 70 
Format · 16, 70 
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.r26 · 78 

.rpt · 76 
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.wb · 74 
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converted data · 74 
surface wave time series · 78 
tide data · 74 
uploaded data · 70 
wave auto-spectrum report · 76 
wave auto-spectrum statistics · 75 
wave data · 74 
wave statistics · 78 
wave time series statistics · 77 

G 
Glossary · 67 

I 
Installation · 14, 33 

L 
Limited liability statement · 2 
Lithium batteries · 7 

M 
Maintenance · 56 
Manual revision history · 102 
Measurement sequence · 69 
Memory · 10 
Memory endurance · 19 
Merge barometric pressure · 38 



Manual revision 017 Index SBE 26 

 104 

P 
Parity · 13 
Parts 

replacement · 100 
Photos · 6 
Plan Deployment · 17 
Plot Data · 49 
Power · 13 
Power consumption · 10 
Power endurance · 19 
Pressure attenuation · 17 
Pressure sensor 

maintenance · 58 
Pressure to depth conversion · 98 
Process Wave Burst Data · 41 
Programming for deployment · 22 

Q 
Quick start · 5 

R 
Recovery · 34 
References · 99 
Replacement parts · 100 
Revision history · 102 

S 
Sample timing · 69 
Seasoft for Waves · 15 

Convert Hex · 36 
Create Reports · 45 
file extensions · 16, 70 
file formats · 16, 70 
installation · 14 
Merge Barometric Pressure · 38 
Plan Deployment · 17 
Plot Data · 49 
Process Wave Burst Data · 41 
SeatermW · 22 
statistics · 85 
theory · 85 
updates · 14 

SeatermW · 22 
Sensors · 10 
Separating wave and tide data · 36 
Sequence · 69 
Setting up SBE 26 · 22 
Shipping precautions · 7 
Software 

statistics · 85 
theory · 85 

Software use · 15 
Specifications · 10 
Statistics · 85, 99 

T 
Testing SBE 26 · 22 
Theory · 85, 99 
Tide data · 74 
Tide data plotting · 49 
Tide data processing · 36, 38 
Timing · 69 
Triton · 67 

U 
Unpacking · 6 
Updates · 14 

V 
Versions · 102 

W 
Wave Burst Data · 41 
Wave data · 74 
Wave data auto-spectrum report · 76 
Wave data auto-spectrum statistics · 75 
Wave data plotting · 49 
Wave data processing · 36, 41, 45 
Wave data surface wave time series · 78 
Wave data time series statistics · 77 
Wave data wave burst statistics · 78 
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